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About Sybase Control Center for Replication

About Sybase Control Center for Replication

Sybase® Control Center for Replication is a Web-based solution that replaces Replication
Monitoring Services (RMS), a middle-tier server, in monitoring the status and availability of
servers in a replication environment.

Sybase Control Center for Replication allows you to monitor and manage large, complex, and
geographically dispersed replication environments. It lets you search, sort, and filter servers
and component objects to support a larger environment than what the current Replication
Manager and Replication Monitoring Services can handle.

Sybase Control Center for Replication provides status information at a glance, using server
monitors and a heat chart for displaying the availability or status of a specific server. The
server monitors display high-level information, such as server version and platform. The
server monitors also display critical performance counters to aid you in troubleshooting
replication performance.

To help you control the flow of data and configure replication parameters to improve server
performance, Sybase Control Center for Replication provides a quick administration tool that
you can easily access through every replication monitor.

In addition to the monitors, Sybase Control Center for Replication provides a topology view
that graphically displays the servers, the connections between servers, data flow in the
environment, and replication path's sources and targets. Graphs and charts are also available
for monitoring performance counters.

You can set user roles to limit access to different features and servers in your environment,
therefore providing better data security.

Replication Environment

Areplication environment is a set of servers—including Replication Servers, data servers, and
Replication Agents—that participate in replication.

A replication environment does not need to contain all the server types in a replication system
domain. It can be a subset of the replication domain identified by the ID Server. In the
replication system, one Replication Server® serves as the ID Server. The ID Server assigns
unique ID numbers to every Replication Server and database in the system. The ID Server also
maintains version information for the system.

These are the servers that you can monitor in your Sybase Control Center replication
environment:

Sybase Control Center for Replication 1



About Sybase Control Center for Replication

Data Server— a database within a data server may act as the source (primary database) of
transaction data or may be the destination (replicate or standby database) of transaction
data.
Replication Agent™ for Adaptive Server Enterprise (ASE) — is embedded within an
Adaptive Server Enterprise and is called RepAgent Thread. The RepAgent Thread reads
the transaction data from the primary database transaction log and sends it to Replication
Server for distribution to the replicate databases.
Replication Server — receives the replicated transaction data from a replication agent or
another Replication Server, converts it into SQL, and applies the SQL to the replicate or
standby databases. Replication Server delivers operational data across complex and
broadly distributed data-infrastructures in near real-time. The primary and replicate
databases can be Sybase or non-Sybase data servers.
Replication Agent — reads the primary database transactions from database transaction
logs, then sends those transactions to Replication Server for distribution to the replicate
databases. Replication Agents allow non-Sybase data servers to act as the primary data
servers in a replication system based on Sybase replication technology.
Mirror Replication Agent —a component in a Mirror Activator disaster recovery
environment and, in conjunction with a storage replication system, reads the primary
database transactions from mirror log devices, then sends those transactions to Replication
Server for distribution to the standby databases. The Mirror Activator provides an
integrated disaster recovery solution with:
« Standby databases protected from disk corruption (by logical, not literal, replication).
« Synchronous replication, with zero data loss and guaranteed data integrity (transaction
consistency).
« Complete coverage for databases, as well as non-database systems.
Sybase 1Q — a highly optimized analytics server that works with diverse data, including
unstructured data and different data sources. It serves as a replicate database in the
replication environment.

The replication environment also includes:

Components — are objects in a server in a replication environment. Examples of
components in a Replication Server are connections, routes, and queues.

Replication path — is the set of servers through which transactions pass when moving
from the primary to the replicate database.

See also

Data Flow Control on page 62
Replication Servers on page 63
Replication Agents on page 70
Replication Paths on page 72
Compatibility Matrix on page 3
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Compatibility Matrix

Know the version of the replication environment servers that are compatible with Sybase
Control Center.

Server Version

Replication Server 12.6 or later

Replication Agent 15.0 or later

Mirror Replication Agent 15.0 or later

Adaptive Server Enterprise 15.0.2 or later for Sybase Control Center for Adaptive Server,

which offers full monitoring capabilities.
15.0.3 or later for Adaptive Server Cluster Edition monitoring

12.5.4 or later for Sybase Control Center for Replication, which
monitors only the RepAgent threads in the registered Adaptive
Server.

Sybase 1Q 15.1 ESD #2.1 or later

See also

e Replication Environmenton page 1

» Data Flow Control on page 62

* Replication Serverson page 63

» Replication Agentson page 70

e Replication Paths on page 72

* Resources

»  Common Display Options

» Registering a Replication Server, Replication Agent, or Mirror Replication Agenton page
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New Features in Sybase Control Center for Replication

New Features in Sybase Control Center for
Replication

A brief description for each new and enhanced feature, and links to associated topics.

Table 1. New and enhanced Sybase Control Center for Replication features

Feature Topics

New script to start and stop Sybase Control Center: | Launching Sybase Control Center

¢ In Windows: scc.bat
¢ In UNIX: scc.sh

Use the scc script to start and stop servers, configure | scc Command
ports, enable and disable services, and more.

Import and register servers in a batch from an inter- | /mporting Resources on page 9
faces file.

Sybase Control Center automatically schedules de- | Replication Data Collections on page 17
fault collections to gather data from managed resour-
ces.

Tools for backing up and restoring the Sybase Control | Repository
Center data repository.

Write a script and configure Sybase Control Center to | Alert-Triggered Scripts on page 50

execute it when a particular alert is triggered. Creating an Alerton page 40

Configure alerts on child objects (such as routes and | Creating an Alert on page 40
paths) that are components of managed resources.

Determine the source, target, and the path of the data | Replication Tracing on page 59
flow anywhere in the replication environment through
replication tracing.

Control data flow and configure replication parame- | Data Flow Control on page 62
ters to resolve performance issues using the Quick

Admin tool. Setting Replication Parameters on page

35

Set up the latency monitoring process to monitor the | Setting Up the Latency Monitoring Process
performance of the replication environment. on page 13

Hide connection thread status in a warm standby en- | Hiding Connection Thread Status on page
vironment and in an environment with a non-Adaptive | 65

Server primary database to avoid providing mislead-
ing information.
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Feature Topics

Monitor the RepAgent thread in an Adaptive Server, | Displaying RepAgent Thread Status in
either single instance or shared disk cluster. Adaptive Serveron page 71

View Sybase 1Q servers in the replication topology as | Replication Topology on page 58
part of the replication environment.

Note: Sybase Control Center for Replication supports
Sybase 1Q only as a replicate database.

Monitor additional Replication Server statistics for | Graphing Performance Counters on page
queues and Data Server Interface (DSI) thread. 56

View information about logical connections associ- | Displaying Logical Connection Status on
ated with a Replication Server. page 64

Check the status bar for information of what is cur- | Replication Monitors on page 60
rently happening in the monitoring view, as well as
warning and error messages. Launch the Sybase Con-
trol Center log viewer through the button in the left
side of the status bar.

Maximize or minimize a chart view in a replication | Replication Monitors on page 60
monitor view.
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Configure

Configure login accounts, statistics collection, and other replication monitoring options.

1. Registering a Replication Server, Replication Agent, or Mirror Replication Agent

Register a resource (for example, a server that can be monitored) to make Sybase Control
Center aware of it and its connection information.

2. Importing Resources
Import and register multiple servers from an interfaces or sgl.ini file.
3. Creating a Perspective
Create a perspective in which you can add and manage resources.
4. Adding a Resource to a Perspective
Add a resource to the current perspective.
5. Configuring a Login Account to Monitor Replication

Use the security configuration options to add one or more roles to a Sybase Control Center
login account or to a group. Roles enable users to perform tasks such as monitoring servers
or administering Sybase Control Center.

6. Authenticating a Login Account for a Monitored Resource

Specify the login account Sybase Control Center will use when it connects to your server
or other resource to collect monitoring data.

7. Setting Up the Latency Monitoring Process
Start the latency monitoring process for replication paths in the replication environment.
8. Setting Up Statistics Collection

Use the Properties view of your managed resource to create a data collection job and add a
schedule to the job.

9. Setting Replication Parameters

Configure replication parameters to improve server performance. Sybase Control Center
for Replication allows you to configure the parameters for Replication Server, Replication
Agent, connection and logical connection, route, and Adaptive Server RepAgent thread.

10. Creating an Alert
Use the Add Alert wizard to create an alert instance for your resource.
11. Optional Configuration Steps

Perform additional configuration, including user authorization, alerts, data collection
scheduling, backups, and setting purging options for the repository.
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Registering a Replication Server, Replication Agent, or
Mirror Replication Agent

Register a resource (for example, a server that can be monitored) to make Sybase Control
Center aware of it and its connection information.

1. Inthe Resource Explorer, select Resources > Register.
2. Specify:

Table 2. New resource type details

Field Description

Resource Name (Required) Name of the resource to register. Enter the actual
name of the server, using uppercase and lowercase letters. If the
name registered in Sybase Control Center does not exactly
match the server name, some monitoring functions, including
the topology view, do not work.

Resource Type Select a resource type:

* ASE Server, Replication Only (12.5.0.0) — monitor only the
RepAgent threads for an Adaptive Server that is older than
version 15.0.2.0. Choose this type for an Adaptive Server
that is part of a replication environment.

* Replication Agent (15.5.0.0) — monitor Replication Agent.

» Replication Server (15.5.0.0) — monitor Replication Server.

Description A brief description to help you identify the resource.

3. Click Next.
4. Specify the connection information for your resource:

Table 3. New resource connection details

Field Description

Server Host Name/Host Name Local host name

Port Number Local host port number

RSSD Host Name (Required) Name of the RSSD host
RSSD Port Number (Required) RSSD host port number

Note: RSSD Host Name and RSSD Port Number are required only if you are registering
a Replication Server.
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5. Click Finish.

See also

o Importing Resources on page 9
* Resources

e Common Display Options

e Compatibility Matrix on page 3

Importing Resources

Import and register multiple servers from ani nt er f aces orsql . i ni file.

Prerequisites
Copythei nt erfacesorsqgl . i ni filetoalocationon oraccessible from the machine that

hosts your web browser.

Aninterfaces (UNIX)orsql .ini file (Windows) is a list of Sybase servers and their
ports; it may contain other connection information as well. The file is created during the
installation of a Sybase server:

e Windows: %SYBASE% i ni\ sql . ini
* Unix: $SYBASE/ i nt er f aces

For more information on i nt er f aces files, see the appendix on configuration files in
Configuration Guide Open Client and Open Server 15.0 for UNIX.

For more informationon sql . i ni files, see the chapter on network communications using
sgl.ini in the Adaptive Server Enterprise 15.0 Configuration Guide for Windows.

Note: The Import Resources wizard imports servers in batches of a single type (Adaptive
Server, Sybase 1Q, or Replication Server, for example). If youri nt er f aces orsql . i ni
file includes resources of more than one type, you must perform this procedure for each
resource type.

1. Inthe application menu, select View > Open > Resource Explorer.

2. Inthe Resource Explorer, select Resources > Import.
The Import Resources wizard opens; Interfaces file is already selected.

3. Click Next.
The Directory Service Connection page appears.

4. Click Browse and navigate to the interfaces file you want to import from.
You cannot type in the File name field.
5. Click Next.

Sybase Control Center for Replication 9
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6. On the Import Resource Type page, select the type of server you want to import.
7. On the Resource Selection page, click to select the servers you want to import.
Select only servers of the type you chose on the Import Resource Type page. If you import

servers with incorrect types, Sybase Control Center will not be able to monitor or manage
them properly.

8. Resources of your chosen type may require connection parameters in addition to those
present in the file—RSSD host name and port for Replication Server, for example, or
character set and language for Adaptive Server. Enter any required connection parameters.

9. Click Next.
The Confirmation page displays a list of the resources you have selected.

10. Click Finish if you are ready to import, or click Back to return to the previous screen and
change your selections.
When you click Finish, Sybase Control Center imports and registers the resources and
displays a summary page.

11. Click Close to finish the wizard.

The newly imported resources appear in the Resource Explorer.

Next
Add the new resources to a perspective so you can monitor and manage them.

See also

* Registering a Replication Server, Replication Agent, or Mirror Replication Agenton page
8

e Creating a Perspective on page 10
e Resources

Creating a Perspective

Create a perspective in which you can add and manage resources.

1. From the application menu bar, select Perspective > Create.
2. Enter a name for your perspective. The name can contain up to 255 characters.
3. Click OK.

See also

» Importing Resources on page 9

* Adding a Resource to a Perspective on page 11
e Removing a Perspective

* Renaming a Perspective

10

Sybase Control Center



Configure

e Perspectives

Adding a Resource to a Perspective

Add a resource to the current perspective.

Add a server or other resource to a perspective so you can monitor and manage it along with
other resources in the same perspective.

1. From the Sybase Control Center toolbar, click the Launch resource explorer icon.

2. Select the resources to add to your perspective. Select multiple resources by pressing the
Ctrl key while you select. Then perform one of these actions:

» Select Resources > Add Resources to Perspective.

« Drag and drop resources from the Resource Explorer onto the Perspective Resources
view. You can select and drag multiple resources.

See also

» Creating a Perspective on page 10

e Configuring a Login Account to Monitor Replication on page 11
* Resources

Configuring a Login Account to Monitor Replication

Use the security configuration options to add one or more roles to a Sybase Control Center
login account or to a group. Roles enable users to perform tasks such as monitoring servers or
administering Sybase Control Center.

Prerequisites
You must have administrative privileges (sccAdminRole) to perform this task. To assign a
monitoring role for a server, first register the server.

Assign the repMonitor and repAdminRole to any login account to perform monitoring and
management tasks in Sybase Control Center.

From the menu bar, select Application > Administration .

In the Sybase Control Center Properties dialog, expand the Security folder.

Click Logins or Groups.

Select the login account or group to which you want to assign a role.

Click the Roles tab.

From the Available roles for resource list, select the role, then click Add.

For example, to grant administrative privileges, add the SCC Service:sccAdminRole.

o gk wbd PR
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If arole appears in the Has following roles list, it means the account or group has already
been configured with that role.

7. Click OK.

See also

Adding a Resource to a Perspective on page 11
Authenticating a Login Account for a Monitored Resource on page 12
User Authorization

Roles or Permissions to Set Up Replication Monitoring Accounts

Sybase Control Center uses the user name and password account that you provide when you
authenticate a server to retrieve monitoring information.

The user account you have specified must have these roles or permissions:

Replication Server — a 'create object’ or 'sa’ permission.

Replication Server System Database (RSSD) database — read privilege on all tables and
create and execute privileges on stored procedures in the RSSD database. It is
recommended to use the account created by rs_init for the RSSD.

Replication Agent or Mirror Replication Agent — an administrative account. There is only
one administrative account in a Replication Agent.

Adaptive Server for RepAgent threads — a system administrator role. Sybase Control
Center uses the dbcc monitor command to retrieve statistics.

Note: 'sa’ or 'dbo’ permission are required for setting parameters and controlling data flow.

Authenticating a Login Account for a Monitored Resource

Specify the login account Sybase Control Center will use when it connects to your server or
other resource to collect monitoring data.

Perform this task for each resource registered with Sybase Control Center.

Note: You can also authenticate a server when you create a collection job.

1. Connect a browser to Sybase Control Center and log in.

In the Perspective Resources view, right-click the icon for your resource and select
Authenticate.

Select Use my current SCC login or Specify different credentials.

If you chose Specify different credentials, enter the login and password for Sybase
Control Center to use to connect to your resource.

If the selected server is a Replication Server, also enter the RSSD user name and password.

12

Sybase Control Center



Configure

6. Click OK to exit the dialog.

See also

e Configuring a Login Account to Monitor Replication on page 11
o Setting Up the Latency Monitoring Process on page 13

o User Authorization

Setting Up the Latency Monitoring Process

Start the latency monitoring process for replication paths in the replication environment.

Prerequisites

» Install and configure all the servers to be monitored. Verify that these servers have been
registered and added to the Perspective Resources, and that you have the permission to
perform this task.

» To use rs_ticket in a replication environment to measure the latency of non-Sybase
replicate databases, you must install JDBC drivers to enable Sybase Control Center for
Replication. See "Installing the JDBC Drivers for Non-Sybase Replicate Databases" in the
Sybase Control Center Installation Guide.

1. From the Perspective Resources view, right-click a Replication Server and select
Monitor.

2. Click Paths.
3. Select a path from the list.

Note: When selecting or highlighting a path, click outside the Path Name column.
Clicking the path name opens the path dashboard.

4. Click Quick Admin to display the latency monitoring process administration view for the
selected path.

Note: The selected path's primary and replicate Replication Server versions must be 15.1
or later, otherwise the Quick Admin option is disabled. For a non-Sybase primary
database, the Replication Agent must also be version 15.1 or later.

All replicate databases to which the selected path replicates data are listed in the
administration view. For Adaptive Server databases, all parameters are populated
automatically. For non-Sybase databases, you need to provide the parameters manually in
the administration view.

5. Specify the replicate database information, start and end dates, and the repeat interval
time.

6. For non-Sybase databases, click Test Connection to verify that the connection
information is valid.

Sybase Control Center for Replication 13
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Note: Repeat this step for all the listed replicate databases.
7. Click Start.

You can click the bar graph icon in the upper-right corner of the Latency window in the
Replication Server Monitor's Paths view or in the Replication Path Dashboard to see the
detailed latency history.

See also

» Authenticating a Login Account for a Monitored Resource on page 12
o Setting Up Statistics Collection on page 15

« Stopping the Latency Monitoring Process on page 74

» Displaying Latency on page 74

» Latency Chart Details on page 75

e Replication Latency on page 73

» Data on Dashboards or Charts Is Missing on page 77

Latency Monitoring Process

Latency monitoring means executing the rs_ticket command at the primary database,
retrieving the latency data from the replicate database, and storing the results in the Sybase
Control Center repository.

rs_ticket gathers time information at various points in the replication path as it flows from the
primary database to the replicate database. You can then use this latency information to
identify bottlenecks in the replication path. Latency information helps ensure that data is
flowing efficiently between the primary and replicate databases.

The latency monitoring process collects data on a specified schedule for each replicate
Replication Server and for the primary Replication Server for the path you configured. The
primary collection executes the rs_ticket command in the primary database. Each replicate
collection performs a collection in all its paths. When a path collection occurs, the results of
the rs_ticket command are retrieved from the replicate database, stored in the repository, and
displayed in the latency history chart in the Replication Server Monitor's Paths view or in the
Replication Path Dashboard for server performance monitoring.

Each collection repeats until the end date or until you manually stop the latency monitoring
process. Once the process is stopped, all collections are deleted from the scheduler.

See also

» Displaying Replication Path Status on page 73

» Displaying Latency on page 74

o Stopping the Latency Monitoring Process on page 74

14
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Setting Up Statistics Collection

Use the Properties view of your managed resource to create a data collection job and add a
schedule to the job.

For best performance, Sybase recommends these guidelines for scheduling data collection
jobs:

« Schedule only one collection job for each collection.
« Set the collection interval to 60 seconds or more.

1. Inthe Perspective Resources view, select a resource and select Resource > Properties.

2. Select Collection Jobs.

3. Click Create Job.
The Create Collection Job window opens.

4, If this resource has not been authenticated yet, the Authentication page appears. Enter a
user name and password that Sybase Control Center can use to log in to the resource. Then
click Authenticate to allow Sybase Control Center to verify your credentials.

5. Select the data collection that this job will run and click Next.

6. (Optional) If you do not want to create a schedule yet, click to uncheck Create a schedule
for this job.

7. Specify details for the new schedule:

Table 4. New schedule details

Field Description

Name A name for this schedule

Description A description of the schedule

Start date The day when the schedule will take effect
Time The time when the schedule will take effect

Note: Enter dates and times using the server’s local time.

8. Choose an option to specify the duration of this schedule:

* Runonce
* Repeat until
For Repeat until, specify these details:

Sybase Control Center for Replication 15
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Field Description

Repeat interval Interval, in seconds, between recurrences to be added to the
schedule

Repeat until End date

Time Time when the job is to end

* Repeat indefinitely
For Repeat indefinitely, specify these details:

Field Description
Repeat interval Interval, in seconds, between recurrences to be added to the
schedule
9. Click Finish.
See also

« Setting Up the Latency Monitoring Process on page 13
« Setting Replication Parameters on page 35
» Job Scheduling

About Statistics

Understand availability and performance statistics in Sybase Control Center.
The statistics you work with in Sybase Control Center can be divided into two types:

< Availability statistics are concerned with present conditions; they help you determine
whether a resource you are monitoring (a server or an agent, for example) is running and
functioning properly.

» Performance statistics are concerned with behavior of the same resources over time. They
describe the flow of data through your environment. You can use performance statistics to
spot trends, identify problems like resource bottlenecks, and make plans.

Sybase Control Center includes predefined key performance indicators (KPIs) for each
product module; these KPIs are grouped into collections. KPIs such as server status, which
serves as an availability statistic when it is fresh, have long-term value as historical
performance statistics.

Auvailability statistics appear on the heat chart and on resource monitoring screens in each
product module.

Performance statistics appear on the statistics chart and on resource monitoring screens in
each product module.

Some KPIsare included in the default collection for each product module. To make other KPIs
available to the heat chart, statistics chart, and resource monitoring views, you must set up

16
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collection jobs in the scheduler. See the data collections help topic for your Sybase Control
Center product module for information on data collections and the KPIs contained in them.

Several configuration options affect the collection and display of data in Sybase Control
Center:

« Collection repeat interval—The frequency of data collection. Set this on the collection job
in the scheduler.

» Screen refresh interval—The period between screen refreshes. Refreshing the screen
redraws it with the newest available data. Set the screen refresh interval in the product
module. (May not be settable in all product modules.)

» Chart trend period—The period over which data is displayed in historical charts. Set the
trend period in the product module. (May not be settable in all product modules.)

See also
» Replication Data Collections on page 17
» Key Performance Indicators and Key Performance Areas for Replication on page 18

Replication Data Collections
Lists and describes predefined data collections you can use to create jobs for Replication.

Table 5. Replication data collection

Replication Ob- . . A

nep Replication Data Collection Description

jects

Replication Server | Monitoring Statistics Collects the availability met-

(default collection®) r_lcs displayed |n_the Replica-
tion Server Monitor and heat

Note: This collection must be scheduled to chart.

enable alerts.

Performance Counters Collects historical perform-
ance metrics that you can later
graph in the statistics chart.

ASE Server, Repli- | RepAgent Statistics Collects availability metrics
cation Only (default collection®) for RepAgent thread.

Note: This collection must be manually star-

ted if the Adaptive Server is registered as an

ASE Server type. "collection_ase_rat" is the

name of the RepAgent Statistics collection in

an ASE Server registered Adaptive Server.
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Replication Ob-

jects Replication Data Collection Description

Replication Agent | RA Monitoring Statistics Collects availability metrics
displayed in the Replication

default collection*
( ) Agent Monitor and heat chart.

Performance Counters Collects historical perform-
ance metrics that you can later
graph in the statistics chart.

*Default collections are automatically created upon authentication and are set to repeat indefinitely at
a 60-second interval.

See also

» About Statistics on page 16

o Alerts

e Creating an Alerton page 40

* Assigning a Role to a Login or a Group
o Configuring the E-mail Server

Key Performance Indicators and Key Performance Areas for Replication

Lists and describes the key performance indicators (KPIs) and key performance areas (KPAS)
that provide the statistics displayed on Replication screens and charts in Sybase Control
Center.

Each Replication KPA includes a subset of the KPlIs.

Table 6. Key performance indicators

KPI Description

Managed Object States

Primary State Managed object primary state.
Secondary State Managed object seconday state.

Replication Server Performance Statistics

Insert commands Insert command on active object.
Update commands total Update command on active object.
Delete commands total Delete command on active object.
Writetext commands total Writetext command on active object.
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KPI

Description

Execute commands total

Execute command on active object.

AIO collect time total

Amount of time that the Asynchronous 1/0O Daemon spent in
collecting async 1/0 requests in which Daemon is obliged to poll
until notified of their completion.

AIOQ after poll total

Number of pending asynchronous 1/0O requests just after the
Async I/0 Daemon finishes polling for their completion.

AIQ before poll total

Number of pending asynchronous 1/0O requests just before the
Async 1/0 Daemon goes off to poll for their completion.

AIQ poll time total

Amount of time that the Asynchronous 1/0 Daemon spent in
polling I/0 completions. This includes the time taken to notify
AIOQ clients of their 1/0 requests completion.

AIO read retry total

The number of times an async read is made and the OpSys tells
the client that it must try again.

AIO write retry total

The number of times an async write is made and the OpSys tells
the client that it must try again.

Alarm milliseconds spent total

Number of milliseconds actually spent before the alarm was
expired.

Alarm cancel total

Number of alarms cancelled.

Alarm examined total

Number of examined alarms to determine whether they are ex-
pired or not.

Alarm expired cancelled total

Number of alarms that were found canceled upon each 'handle
expiration' execution.

Alarm expired total

Number of alarms that have expired upon each 'handle expira-
tion' execution.

Alarm milliseconds expired inter-
val total

Number of milliseconds until the next alarm expiration.

Alarm expired time total

Amount of time elapsed while handling expired alarms.

Alarm milliseconds requested total

Number of milliseconds originally requested for the alarm when
it was set.

Alarm set total

Number of alarms set.

Thread start total

Total number of started threads.

Thread stop total

Number of threads stopped.
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KPI

Description

Begins total

Begin Tran statements sent to Replication Server System Data-
base (RSSD).

Deletes total

Delete statements sent to RSSD.

Inserts total

Insert statements sent to RSSD.

Selects total

Select statements sent to RSSD.

Cache exceed total

Number of time System Table Services (STS) cached was ex-
ceeded.

Updates total

Update statements sent to RSSD.

Replication Server

Replication Server State

The state of the Replication Server.

% Memory usage

The percent of the current memory used by the server.

Maximum Latency

The highest latency of any replication path in the server.

% Partition Usage

The percent full of all partitions in the Replication Server.

Path

Path Status

The state of the replication path between a primary and a rep-
licate database.

Path Latency

The time between when a transaction is committed at the pri-
mary database and when it is committed at the replicate data-
base.

Change in Path Activity

The number of commands sent to the replicate database by the
Data Server Interface (DSI) thread since the last monitoring
cycle.

Path Data Loss

Indicates possible data loss between the primary and replicate
databases.

rs_ticket Count

The ticket's unique sequence number.

Primary Database Start Time

The time, in milliseconds, the rs_ticket was executed at the
primary database.

Executor Thread Latency

The number of milliseconds from the start, to the time the ticket
passes through the executor thread.
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KPI

Description

Distributor Thread Latency

The number of milliseconds from the primary Replication Serv-
er time, to the time the ticket passes through the distributor
thread.

Replication Server Interface La-
tency

The number of milliseconds from the distributor (DIST) thread
time, to the time the ticket passes through the Replication Server
Interface (RSI) thread.

Data Server Interface Thread

The number of milliseconds from the RSI thread time, to the
time the ticket passes through the DSI thread.

Path RDB Latency

The number of milliseconds from the DSI thread time, to the
time the ticket arrived at the replicate database.

Connection

Time closing an OB fadeout total

The amount of time spent closing a connection marked to be
faded out.

Time waiting on OB fadeout total

The amount of time spent waiting for a connection marked to be
faded out.

Commands read total

Commands read from an inbound queue by a DIST thread.

Resolved delete statements total

Delete commands encountered by a DIST thread and resolved
by subscription resolution engine (SRE).

Unresolved statements total

DIST commands with no subscription resolution that a DIST
thread discarded. This implies either there is no subscription or
the 'where' clause associated with the subscription does not re-
sult in row qualification.

Resolved insert statements total

Insert commands that a DIST thread encountered, which SRE
resolved.

Resolved update statements total

Update commands that a DIST thread encountered, which SRE
resolved.

TD Begins total

Begin transaction commands that a DIST thread propagated.

TD Commits or Rollbacks total

Commit or Rollback commands that a DIST thread processed.

Transactions processed total

Transactions read by DIST thread from an inbound queue.

All large threads used total

This counter is incremented each time a Large Parallel Trans-
action must wait because there are no available parallel DSI
threads.

Sybase Control Center for Replication
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KPI

Description

All threads used total

This counter is incremented each time a Parallel Transaction
must wait because there are no available parallel DSI threads.

Commands applied successfully
total

Commands that a DSI successfully applied to the target data-
base.

Time dispatching large groups to-
tal

Time spent by the Data Server Interface, scheduler thread (DSI/
S) dispatching a large transaction group to a DSI/E. This in-
cludes the time spent finding a large group to dispatch.

Time dispatching regular groups
total

Time that the DSI/S spent dispatching a regular transaction
group to a DSI/E.

Time finding regular groups total

Time that the DSI/S spent finding a group to dispatch.

Time loading SQT cache total

Time that the DSI/S spent loading Stable Queue Transaction
(SQT) cache.

Time executing special group total

Time that the DSI/S spent determining if a transaction is special,
and executing it if it is.

DSI/E in sleep mode total

Number of DSI/E threads that the DSI/S put to sleep prior to
loading SQT cache. These DSI/E threads have just completed
their transaction.

Time putting DSI/E in sleep mode
total

Time that the DSI/S spent putting free DSI/E threads to sleep.

Transaction groups read total

Transaction groups that the DSI read. If grouping is disabled,
grouped and ungrouped transaction counts are the same.

Ungrouped transactions read total

Ungrouped transactions that the DSI read. If grouping is disa-
bled, grouped and ungrouped transaction counts are the same.

Transaction groups committed to-
tal

Transactions that a DSI thread successfully committed.

Transaction groups sent total

Transaction groups that the DSI thread sent to the target data-
base. A transaction group can contain at most

dsi_max_xacts_in_group transactions. This counter is incre-
mented each time a 'begin’ for a grouped transaction is executed.

Transaction groups success total

Transaction groups that a DSI thread successfully applied to a
target database. This includes transactions that were success-
fully committed or rolled back according to their final disposi-
tion.
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KPI

Description

Transaction groups committed to-
tal

Transactions in groups sent by a DSI thread that committed
successfully.

Transaction groups sent total

Transactions contained in transaction groups that a DSI thread
sent.

Closed groups maximum bytes to-
tal

Transaction groups that a DSI thread closed due to the next
transaction that caused the dsi_xact_group_size to exceed.

Closed groups next new origin to-
tal

Transaction groups that a DSI closed due to no open group from
the origin of the next transaction. For example, there is a new
origin in the next transaction, or the schedule forced a flush of
the current group from the origin leaving no open group from
that origin.

Closed groups partitioning total

Transaction groups that a DSI thread closed because of a Trans-
action Partitioning rule.

Closed groups maximum log trans-
action total

Transaction groups that a DSI thread closed due to the next
transaction that caused the dsi_max_xacts_in_group to ex-
ceed.

Groups wait partitioning total

Transaction groups forced to wait for another group to complete
(processed serially based on Transaction Partitioning rule).

True return of
rs_dsi_check_thread_lock total

Number of rs_dsi_check_thread_lock invocations returning
true. The function determined the calling thread holds locks
required by other threads. A rollback and retry occurred.

Delete statements read total

rs_delete commands that a DSI executor (DSIEXEC) thread
processed.

Batch size total

Size, in bytes, of commands batches, which a DSI submitted.

Batch time total

Time, in milliseconds, to process command batches, which a
DSI submitted.

Bytes succeed total

Bytes that a DSI/E successfully applied to the target database.

Commands read total

Commands read from an outbound queue by a DSIEXEC
thread.

Commands succeed total

Commands that a DSI/E successfully applied to the target da-
tabase.

Function string mapping time total

Time, in milliseconds, to perform function string mapping on
commands.
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KPI

Description

Input command count total

Number of input commands in command batches that a DSI
submitted.

Output command count total

Number of output commands in command batches that a DSI
submitted.

Result time total

Time, in milliseconds, to process the results of commands
batches that a DSI submitted.

Sequencing check on command
batches time total

Time, in milliseconds, to check the sequencing on command
batches, which required some kind of synchronization such as
wait_for_commit.

Sequencing check on commits
time total

Time, in milliseconds, to check the sequencing on commits.

Transaction time total

Time, in milliseconds, for a DSI/E thread to process transac-
tions. This includes function string mapping, sending and pro-
cessing results. A transaction may span command batches.

Errors deadlock total

Times that a DSI thread failed to apply a transaction due to
deadlocks in the target database (ASE Error 1205).

Errors out of lock total

Times that a DSI thread failed to apply a transaction due to no
locks available in the target database (ASE Error 1204).

Writetext total

rs_writetext commands that a DSIEXEC thread processed.

Insert total

rs_insert commands that a DSIEXEC thread processed.

MemUsed group total

Memory that a DSI/S thread consumed for transaction groups.

Send RPC time total

Time, in milliseconds, spent in sending RPCs to the RDS.

Send time total

Time, in milliseconds, spent in sending command buffers to the
RDS.

System transaction read total

Internal system transactions that a DSIEXEC thread processed.

Transaction groups scheduled total

Transactions groups scheduled to a DSIEXEC thread.

Ungrouped transactions scheduled
total

Transactions in transaction groups scheduled to a DSIEXEC
thread.

Updates read total

rs_update commands that a DSIEXEC thread processed.

Bytes received total

Bytes that a RepAgent thread received. This size includes the
TDS header size when in 'passthru’ mode.
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KPI Description

Mini abort total mini-abort commands (in Adaptive Server, SAVEXACT re-
cords) that a RepAgent thread processed. mini-abort instructs
Replication Server to rollback commands to a specific OQIQ

value.
Commands received total Commands that a RepAgent thread received.
Write wait time total The amount of time the RepAgent spent waiting for the Stable

Queue Manager (SQM) Writer thread to drain the number of
outstanding write requests to get the number of outstanding
bytes to be written under the threshold.

Yield time total The amount of time the RepAgent spent yielding the processor
while handling Log Transfer Language (LTL) commands each
time the processor was yielded.

Execution time total The amount of time, in milliseconds, RepAgent user thread is
scheduled by Open Client/Server (OCS).

Receive time total The amount of time, in milliseconds, spent receiving network
packets or language commands.

Update rs_locator total Updates to RSSD. rs_locater where type = 'e' executed by a
RepAgent thread.

Replication Agent Thread State The state of the Replication Agent thread in the Replication
Server that is associated with the connection.

DSI State The state of the DSI thread in the Replication Server that is
associated with the connection.

DSI Activity The number of commands that the DSI thread sent to the repli-
cate database.

DSI Activity per Second The number of commands that the DSI thread sent to the repli-
cate database per second.

Transaction Ignored The number of transactions that were ignored.

Transaction Skipped The number of transactions that were skipped.

Transaction Succeeded The number of transactions that were successfully committed to

the replicate database.

Transaction Failed The number of transactions that were failed.

Transaction Retried The number of transactions that were retried.
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KPI

Description

DSI SQT Cache Percent Used

The percent of DSI SQT cache size used.

Transactions removed per second

The number of transactions removed from the DSI SQT cache
per second.

SQT cache low boundry

The smallest size to which DSI SQT cache is configured before
transactions start being removed from the cache.

Transactions read per second

The number of transactions that the DSI read per second.

Commands per Transaction

The number of commands per transaction.

Transactions per Group

The number of transactions per group.

Commands per Batch

The number of commands per batch.

Logical Connection

Operation in Progress State

The state of the operation in progress.

Route

Route State The state of the route at both the origin and destination Repli-
cation Servers.

Route Activity The number of bytes sent to the destination Replication Server.

Route Activity per Second

The number of bytes sent to the destination Replication Server
per second.

Alarm time spent total

Number of milliseconds actually spent before an alarm expired.

Time spent cancelling alarms total

Amount of time elapsed while canceling an alarm.

Expired alarms to be cancelled to-
tal

Number of alarms that were found to have been expired while
attempting to cancel them.

Alarm required time total

Number of milliseconds originally requested for the alarm when
it was set.

Alarm set total

Amount of time elapsed while setting an alarm.

Connection active time total

Amount of time elapsed while a thread makes a connection
active.

Connection charset time total

Amount of time elapsed while checking a connection's character
set.
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KPI

Description

Connection fadeout freetime total

Amount of time elapsed while this thread's free connections are
marked for fadeout. Note that this thread is probably *not* the
thread doing the work. Most likely it is the Alarm Handler doing
the work.

Connection fadeout time total

Amount of time elapsed while this thread's assigned connec-
tions are marked for fadeout. Note that this thread is probably
*not* the thread doing the work. Most likely it is the Alarm
Handler doing the work.

Connection give-up total

Number of times the thread gave up a connection.

Connection give-up time total

Amount of time elapsed while a thread gives up a connection.

Connection idle time total

Amount of time elapsed while a thread makes a connection idle.

Connection open total

Number of times the thread made a connection request and
received one that had to be opened.

Connection request total

Number of times the thread made a connection request and
received one that was already open.

Connection sort order time total

Amount of time elapsed while checking a connection's sort or-
der.

Connection time total

Amount of time elapsed while a thread obtains a connection.

Message queue get time total

Number of centiseconds spent getting a message from an inter-
nal message queue.

Message queue put time total

Number of centiseconds spent putting a message on an internal
message queue.

Sleep time total

Amount of time elapsed after a thread puts itself to sleep.

Yield time total

Amount of time elapsed after a thread yields the CPU.

Blocks read total

Number of blocking (SQM_WAIT_C) reads that an RSI thread
performed against SQM thread that manages a RSI queue.

Bytes sent total

Bytes that an RSI sender thread delivered.

Messages sent total

RSI messages that an RSI thread sent. These messages contain
the distribute command.

Packets sent total

Packets that an RSI sender thread sent.

Send packet time total

Time, in milliseconds, spent in sending packets of data to the
RRS.
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KPI

Description

Bytes received total

Bytes that an RSI user thread received. This size includes the
TDS header size when in 'passthru’ mode.

Command length total

Length of an RSI command.

Commands received total

Commands that an RSI user thread received. Includes RSI mes-
sage, get truncation requests, etc.

Execution time total

The amount of time, in milliseconds, RSI User thread is sched-
uled by OCS.

Receive packet time total

The amount of time, in milliseconds, spent receiving network
packets.

GetTrunc send time total

The amount of time, in milliseconds, spent responding to 'get
truncation' requests.

SetTrunc send time total

The amount of time, in milliseconds, spent responding to 'set
truncation' requests.

Queue

Queue Writes

The number of commands written to the queue in the Replica-
tion Server.

Queue Writes per Second

The number of commands written to the queue in the Replica-
tion Server per second.

Queue Reads

The number of commands read from the queue in the Replica-
tion Server.

Queue Reads per Second

The number of commands read from the queue in the Replica-
tion Server per second.

Queue Bytes

The number of bytes written to the queue in the Replication
Server.

Queue Bytes per Second

The number of bytes written to the queue in the Replication
Server per second.

Queue Size

The size of the queue in the Replication Server.

Queue SQT Cache Percent Used

The percent of SQT cache size used for inbound queue.

Duplicates Transaction during
monitoring interval

The number of duplicate commands detected and ignored by the
SQM.

Transactions removed per second

The number of transactions removed from the SQT cache per
second.
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KPI

Description

SQT cache low boundry

The smallest size to which SQT cache would be configured
before transactions start being removed from cache.

Commands processed by DIST per
second

The number of commands that the distributor thread processed
for an inbound queue per second.

Commands processed without rep
def per second

The number of commands that did not have an associated rep-
lication definition, which the distributor thread processed for an
inbound queue per second.

Percent of blocks that were full
when written to the queue

The percentage of blocks that were full when written to the
queue.

Percent of reads that came directly
from the cache

The percentage of reads that came directly from the cache.

Blocks full write total

Number of full blocks that an SQM thread wrote. Individual
blocks can be written due either to block full state or to sysadmin
command slow_queue (only one message per block).

Blocks written total

Number of 16K blocks that an SQM thread wrote to a stable
queue.

Bytes written total

Bytes that an SQM thread wrote to a stable queue.

Commands written total

Commands that an SQM thread wrote to a stable queue.

Command size total

Command size written to a stable queue.

Segments active total

Active segments of an SQM queue: the number of rows in
rs_segments for the given queue where used_flag = 1.

Queue segments allocated total

Segments allocated to a queue during the current statistical pe-
riod.

Queue segments deallocated total

Segments deallocated from a queue during the current statistical
period.

Time new segments allocated total

The elapsed time, in milliseconds, to allocate a new segment.
Timer starts when a segment is allocated. Timer stops when the
next segment is allocated.

Updates to rs_oqid total

Updates to the RSSD. rs_oqid table by an SQM thread. Each
new segment allocation may result in an update of rs_oqid value
stored in rs_oqid for recovery purposes.

Write requests total

Message writes that an SQM client requested.
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KPI

Description

Write timer pop total

SQM writer thread initiated a write request due to timer expi-
ration.

Blocks read total

Number of 16 blocks that an SQM Reader (SQMR) thread read
from a stable queue.

Blocks read cached total

Number of 16K blocks that an SQMR thread read from a cache.

Commands read total

Commands that an SQMR thread read from a stable queue.

Time waiting for queue write total

The amount of time SQMR wait for a queue write.

Unread blocks total

The number of blocks within a partially read segment that are
yet to be read.

Unread segments total

The number of segments yet to be read.

Read time total

The amount of time taken for SQMR to read a block.

Memory used total

SQT thread memory use. Each command structure allocated by
an SQT thread is freed when its transaction context is removed.
For this reason, if no transactions are active in SQT, SQT cache
usage is zero.

Transactions added closed total

Transactions added to the Closed queue.

Transactions removed closed total

Transactions removed from the Closed queue.

Commands read total

Commands read from SQM. Commands include XREC_BE-
GIN, XREC_COMMIT, XREC_CHECKPT.

Commands in tran total

Commands in transactions completely scanned by an SQT
thread.

Transactions added total

Transactions added to the Open queue.

Transactions removed total

Transactions removed from the Open queue.

Transactions added Read Q total

Transactions added to the Read queue.

Transactions removed Read Queue
total

Transactions removed from the Read queue.

Cache lower bound size total

The smallest size to which SQT cache can be configured before
transactions start being removed from cache.

Closed transactions total

Current closed transaction count.

Open transactions total

Current open transaction count.
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KPI

Description

Read transactions total

Current read transaction count.

Truncation queue transaction total

Current truncation queue transaction count.

Transactions removed total

Transactions whose constituent messages have been removed
from memory. Removal of transactions is most commonly
caused by a single transaction exceeding the available cache.

Truncation queue transactions
added total

Transactions added to the Truncation queue.

Truncation queue transactions re-
moved total

Transactions removed from the Truncation queue

Partition

Partition State

The state of the partition in the Replication Server.

Partition Usage

The percent of the partition in the Replication Server that is
currently in use.

RepAgent

Replication Agent State

The state of the Replication Agent.

RepAgent VM

VM maximum memory

Maximum memory (in bytes) available to the Java Virtual Ma-
chine (VM).

VM total memory allocated

Total memory (in bytes) allocated to the Java VM at start-up.

VM free memory

Memory (in bytes) allocated but not used by the Java VM.

VM memory usage

Memory (in bytes) allocated and in use by the Java VM.

VM % max memory used

Percentage of the the maximum memory available to the Java
VM, currently in use by the Java VM.

RepAgent LTI Statistics

Number of LTL commands sent

Total number of LTL commands sent to Replication Server.

LTL Commands Sent per Second

LTL commands sent to Replication Server per second.

Avg LTL command size

Average size (in bytes) of each LTL command sent to Replica-
tion Server.

Avg LTL commands/sec

Average number of LTL commands sent per second to Repli-
cation Server.
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KPI

Description

Total bytes sent

Number of bytes sent to Replication Server.

Avg Bytes/second during trans-
mission

Average bytes per second sent over connection to Replication
Server.

Avg LTL buffer cache time

Average time (in milliseconds) it takes between placing the LTL
commands into the LTL buffer to the time itis actually sent to the
Replication Server.

Avg Rep Server turnaround time

Average time (in milliseconds) it takes Replication Server to
acknowledge each LTL command buffer sent.

Avg data arrival time

Average time (in milliseconds) log transfer interface (LTI) waits
between receiving change sets from Log Reader.

Avg time to create distributes

Average time (in milliseconds) LTI takes to convert a change-set
into LTL.

Avg LTL buffer size

Average size (in bytes) of each LTL buffer sent to Replication
Server

Avg LTM buffer utilization (%)

Average utilization (in percentage of LTL buffer size) of each
LTL buffer sent to Replication Server.

Avg LTL commands/buffer

Average number of LTL commands per buffer sent to Replica-
tion Server.

LTI encoded column name cache
size

Encoded column name cache size.

LTI input queue size

Number of change sets in the LTI input queue

LTI output queue size

Current number of LTL commands in the LTI output queue.

RepAgent Log Reader Statistics

Total operations scanned

Number of operations read from the database transaction log.

Operations Scanned per Second

Number of operations read from the database transaction log per
second.

Total operations processed

Number of operations processed from the database transaction
log.

Operations Processed per Second

Number of operations process from the database transaction log
per second.

Total operations skipped

Number of operations read from the database transaction log
and skipped for any reason.
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Description

Operations Skipped per Second

Number of operations read from the database transaction log
and skipped for any reason per second.

Current operation queue size

Current size (in bytes) of the Log Reader input queue.

Current scan buffer size

Current size (in bytes) of the Log Reader scan buffer.

Total maintenance user operations
filtered

Number of maintenance-user operations read from the database
transaction log and skipped.

Total Maintenance User Opera-
tions Filtered per Second

Number of maintenance-user operations read from database
transaction log and skipped per second.

RepAgent LTM Statistics

Items held in Global LRU Cache

Number of object references in the internal Least Recently Used
cache.

Adaptive Server RepAgent Thread

ASE Replication Agent Thread
Status

The status of the Adaptive Server RepAgent thread in the data
Sserver.

ASE Replication Agent Thread
Log

The difference between the current marker and the end of the
log.

ASE Replication Agent Thread
Operations Scanned

The number of operations scanned from the Adaptive Server
transaction log since the last monitoring cycle.

ASE Replication Agent Thread
Commands Processed

The number of commands processed and sent to the Replication
Server since the last monitoring cycle.

Table 7. Key performance areas

KPA

Description

KPA_RS_PERF_STATS

Replication Server common statistics.

KPA_RS_HEATCHART

Replication Server heat chart statistics.

kpa_path

Replication path statistics.

KPA_PATH_RS_TICKET

The latency times at various points in the path between the
primary database and the replicate database.

kpa_connection

Replication Server connection statistics.

KPA_CONNEC-
TION_PERF_STATS

Replication Server connection performance statistics.
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KPA

Description

kpa_logical_connection

Replication Server logical connection statistics.

kpa_route

Replication Server route statistics.

KPA_ROUTE_PERF_STATS

Replication Server route performance statistics.

kpa_queue

Replication Server queue statistics.

KPA_QUEUE_PERF_STATS

Replication Server queue performance statistics.

kpa_partition

Replication Server partition statistics.

Availability Statistics

Replication Agent availability statistics.

VM Statistics

Replication Agent performance statistics on JAVA VM com-
ponent.

LTM component Statistics

Replication Agent performance statistics on log transfer
manager (LTM) component.

LTI component Statistics

Replication Agent performance statistics on LTI component.

LR component Statistics

Replication Agent performance statistics on log reader (LR)
component.

kpa_ase

Adaptive Server statistics

kpa_rat_ctrl_availability

Adaptive Server RepAgent thread controller availability sta-
tistics.

kpa_rat_availability

Adaptive Server RepAgent thread availability statistics.

See also

»  Historical Performance Monitoring on page 56

e Heat Charton page 55

e Replication Latency on page 73

* Auvailability Monitoring on page 58

» About Statistics on page 16

o Alerts

e Creating an Alert on page 40

» Assigning a Role to a Login or a Group

e Configuring the E-mail Server
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Setting Replication Parameters

Configure replication parameters to improve server performance. Sybase Control Center for
Replication allows you to configure the parameters for Replication Server, Replication Agent,
connection and logical connection, route, and Adaptive Server RepAgent thread.

See also
» Setting Up Statistics Collection on page 15
e Creating an Alert on page 40

Configuring Replication Server and Replication Agent Parameters
Configure Replication Server and Replication Agent parameters.

Prerequisites
Add all the servers to be monitored to the Perspective Resources view, authenticate them, and
verify that you have the permission to perform this task.

1. From the Perspective Resources view, right-click a server and select Monitor.

2. Click Quick Admin.

3. In the Configure tab, modify the current value of the server parameter in the Run Value
column.

Note: Use the filter text box and check box options to search for the parameter you want to
modify.

4. Click Apply All.
5. (Optional) Click Reset All to undo modifications that have not been applied.

Note: Not all of Replication Server and Replication Agent parameters can be configured.
If a parameter cannot be configured, the text box in the administration view is greyed out.

See also

e Quiescing or Resuming Replication Serveron page 67

» Suspending or Resuming a Connection's Replication Agenton page 67

e Suspending or Resuming a Connection on page 68

o Suspending or Resuming a Route on page 69

 Starting or Stopping an Adaptive Server RepAgent Thread on page 72

e Configuring Connection Parameters for Replication Serveron page 36

e Configuring Logical Connection Parameters for Replication Serveron page 37
»  Configuring Route Parameters for Replication Serveron page 37

e Configuring Adaptive Server RepAgent Thread Parameters on page 38
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Configuring Replication Server to Gather Zero Values for Counters on page 39
Data Flow Control on page 62

Configuring Connection Parameters for Replication Server

Configure connection parameters that affect database connections originating from the
Replication Server.

Prerequisites
Add all the servers to be monitored to the Perspective Resources view, authenticate them, and
verify that you have the permission to perform this task.

1. From the Perspective Resources view, right-click a server and select Monitor.

2. Click Connections.

3. Select a connection and click Quick Admin.

4. In the Configure tab, modify the current value of the connection parameter in the Run
Value column.
Note: Use the filter text box and check box options to search for the parameter you want to
modify.

5. Click Apply All.

6. (Optional) Select Recycle connection before you click Apply All to allow Replication
Server to suspend, then resume connection.
Note: This option allows the new parameters to be applied to the connection. If you click
Apply All without selecting Recycle connection, the parameters are not applied to the
connection until the connection is restarted.

7. (Optional) Click Reset All to undo modifications that have not been applied.

See also

Quiescing or Resuming Replication Serveron page 67

Suspending or Resuming a Connection’s Replication Agent on page 67
Suspending or Resuming a Connection on page 68

Suspending or Resuming a Route on page 69

Starting or Stopping an Adaptive Server RepAgent Thread on page 72
Configuring Replication Server and Replication Agent Parameters on page 35
Configuring Logical Connection Parameters for Replication Serveron page 37
Configuring Route Parameters for Replication Server on page 37

Configuring Adaptive Server RepAgent Thread Parameters on page 38
Configuring Replication Server to Gather Zero Values for Counters on page 39
Data Flow Control on page 62
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Configuring Logical Connection Parameters for Replication Server

Configure Replication Server parameters that apply to logical connections for warm standby
applications.

Prerequisites
Add all the servers to be monitored to the Perspective Resources view, authenticate them, and
verify that you have the permission to perform this task.

1. From the Perspective Resources view, right-click a Replication Server and select
Monitor.

2. Click Logical Connection.
3. Select a logical connection and click Quick Admin.

4. Inthe Configure tab, modify the current value of the logical connection parameter in the
Run Value column.

Note: Use the filter text box and check box options to search for the parameter you want to
modify.

5. Click Apply All.
6. (Optional) Click Reset All to undo modifications that have not been applied.

See also

e Quiescing or Resuming Replication Serveron page 67

» Suspending or Resuming a Connection’s Replication Agenton page 67

» Suspending or Resuming a Connection on page 68

o Suspending or Resuming a Route on page 69

» Slarting or Stopping an Adaptive Server RepAgent Thread on page 72

»  Configuring Replication Server and Replication Agent Parameters on page 35
e Configuring Connection Parameters for Replication Serveron page 36

e Configuring Route Parameters for Replication Serveron page 37

e Configuring Adaptive Server RepAgent Thread Parameters on page 38

e Configuring Replication Server to Gather Zero Values for Counters on page 39
e Data Flow Control on page 62

Configuring Route Parameters for Replication Server

Configure parameters that affect routes from the current Replication Server to other
Replication Servers.

Prerequisites
Add all the servers to be monitored to the Perspective Resources view, authenticate them, and
verify that you have the permission to perform this task.
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M w D e

From the Perspective Resources view, right-click a server and select Monitor.
Click Routes.
Select a route and click Quick Admin.

In the Configure tab, modify the current value of the route parameter in the Run Value
column.

Note: Use the filter text box and check box options to search for the parameter you want to
modify.

5. Click Apply All.
6. (Optional) Select Recycle route before you click Apply All to allow Replication Server to

suspend, then resume the route.

Note: This option allows the new parameters to be applied to the route. If you click Apply
All without selecting Recycle route, the parameters are not applied to the route until the
route is restarted.

(Optional) Click Reset All to undo modifications that have not been applied.

See also

Quiescing or Resuming Replication Serveron page 67

Suspending or Resuming a Connection's Replication Agent on page 67
Suspending or Resuming a Connection on page 68

Suspending or Resuming a Route on page 69

Starting or Stopping an Adaptive Server RepAgent Thread on page 72
Configuring Replication Server and Replication Agent Parameters on page 35
Configuring Connection Parameters for Replication Serveron page 36
Configuring Logical Connection Parameters for Replication Serveron page 37
Configuring Adaptive Server RepAgent Thread Parameters on page 38
Configuring Replication Server to Gather Zero Values for Counters on page 39
Data Flow Control on page 62

Configuring Adaptive Server RepAgent Thread Parameters

Configure Adaptive Server RepAgent thread parameters that affect replication performance.

Prerequisites
Add all the servers to be monitored to the Perspective Resources view, authenticate them, and
verify that you have the permission to perform this task.

1.

2.

From the Perspective Resources view, right-click an Adaptive Server and select
Monitor.

Select a RepAgent thread.
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3. Click Quick Admin.

4. In the Configure tab, modify the current value of the RepAgent thread parameter in the
Run Value column.

Note: Use the filter text box and check box options to search for the parameter that you
want to modify.

5. Click Apply All.
6. (Optional) Click Reset All to undo modifications that have not been applied.

Note: Not all of Adaptive Server RepAgent thread parameters can be configured. If a
parameter cannot be configured, the text box in the administration view is greyed out.

See also

e Quiescing or Resuming Replication Serveron page 67

» Suspending or Resuming a Connection's Replication Agenton page 67

»  Suspending or Resuming a Connection on page 68

o Suspending or Resuming a Route on page 69

» Slarting or Stopping an Adaptive Server RepAgent Thread on page 72

e Configuring Replication Server and Replication Agent Parameters on page 35
e Configuring Connection Parameters for Replication Serveron page 36

e Configuring Logical Connection Parameters for Replication Serveron page 37
» Configuring Route Parameters for Replication Serveron page 37

» Configuring Replication Server to Gather Zero Values for Counters on page 39
e Data Flow Control on page 62

Configuring Replication Server to Gather Zero Values for Counters

Set the Replication Server parameter to gather zero values for performance counters when you
run a collection job.

Prerequisites

Add all the servers to be monitored in the Perspective Resources, and verify that you have
permission to perform this task.

If you want zero values to be gathered for performance counters, run this command in the
Replication Server:

configure replication server set stats_show zero_counters to
"on”

See also

* Quiescing or Resuming Replication Serveron page 67

o Suspending or Resuming a Connection's Replication Agenton page 67
» Suspending or Resuming a Connection on page 68
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»  Suspending or Resuming a Route on page 69

» Starting or Stopping an Adaptive Server RepAgent Thread on page 72

o Configuring Replication Server and Replication Agent Parameters on page 35
e Configuring Connection Parameters for Replication Serveron page 36

e Configuring Logical Connection Parameters for Replication Serveron page 37
» Configuring Route Parameters for Replication Serveron page 37

e Configuring Adaptive Server RepAgent Thread Parameters on page 38

» Data Flow Control on page 62

Creating an Alert

Use the Add Alert wizard to create an alert instance for your resource.

Prerequisites

* You must have administrative privileges (sccAdminRole) to perform this task.

» Specify an e-mail server for Sybase Control Center to use for alerts. If an e-mail server is
not configured, you cannot create alert subscriptions.

» Schedule data collections. Alerts for each product module are based on one or more data
collections. If the correct collection or collections are not scheduled to run, the alert system
cannot function and no alerts are generated. See the data collections topic for your product
module for information on which collections you need to schedule to enable alerts.

« (Optional) If you want this alert to trigger the execution of a shell script, copy the scriptto a
location on or accessible from the machine that hosts your Sybase Control Center server.

Warning! Use caution in writing scripts. A poorly designed script can cause a blocking
situation, creating a lock-up in your Sybase Control Center server.

Note: Only alerts on Adaptive Server or Replication Server resources can trigger script
execution.

1. Inthe Perspective Resources view, click the server or other resource and select Resource
> Properties in the view’s menu bar.

2. Select Alerts in the left pane and click Add.
The Add Alert Wizard opens. If the selected resource supports child alerts, the wizard
opens to the Resource page. If the resource does not support child alerts, the wizard opens
to the Type page.

3. On the Resource page of the wizard, select the object on which you want to set the alert.
Expand the folder representing the server or agent to select lower-level child objects.

4. Click Next.
The Type page of the wizard appears.

5. Select the alert type and click Next.
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For this step and the next one, see the topic on key performance indicators for information
on what this alert monitors and how it is triggered. (Each alert is based on a KP1.)

6. Based on the type of alert you selected, do one of the following:

» For a state-based alert: Select a severity level for each alert state.

Note: You can associate only one severity level with each state.

« For athreshold-based alert: Review and if necessary adjust the range of values that
defines each severity.

7. Click Next.
The Storm Suppression page of the wizard appears.

8. Enter the storm suppression period, which suppresses redundant alerts resulting from the
same condition (an alert storm) for the specified period of time. (The default is 60
seconds.) Enter this value in seconds, minutes, or hours in Storm Suppression Period and
click Next.

9. (Optional; not available for alerts on Sybase 1Q servers) To configure this alert to trigger
the execution of a script:

a) Type Configuration specifies the alert severity level that triggers the script. Select
Critical, Warning, or both.
Critical is more serious than Warning.

b) Enter or browse to the location of the script.

c) Enter parameter values in the Execution Parameters box.
The string you enter is passed on the command line to the script. You can include a
number of predefined substitution parameters, which are replaced by values from the
alert. See the example (below) and the substitution parameters topic (linked below) for
more information.

d) Click Next.

If the selected resource has sibling resources (databases or devices of the same type, for

example) that support this alert type, the Duplicates page appears. If the selected resource

has no identical siblings, the Subscription page appears.

10. (Optional) On the Duplicates page, select any resources that should use this alert definition
as a template for their own alerts. Click the box at the top of the list to select all the
resources listed. Then click Next.

This step saves time when you need to configure similar alerts for several resources of the
same type.

11. (Optional) On the Subscription page, specify e-mail addresses if you want this alert to
issue e-mail notifications when it fires.

The e-mail addresses default to the address in your user profile, but you can override the
defaults.

For both critical and warning alerts:
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Table 8. Alert subscription details

Option

Description

E-mail Message

To send an e-mail notification when this alert fires, click the E-mail
Message box and enter the e-mail address of one user or list.

Escalation E-mail

To escalate this alert (by sending an e-mail notification to another
address when this alert has not been responded to after a specified
period of time), click the Escalation E-mail box and enter the e-mail
address of one user or list. Note that you cannot enter an escalation
address unless you enter an address for primary notification first.

Time Period Enter the amount of time to wait, following the initial alert notification,
before Sybase Control Center sends an e-mail notification to the esca-
lation address.

12. Click Finish.

Example: An alert-triggered script

This sample script is a Windows . bat file:

@cho off
@cho. >> stest.txt

@cho %dat e% % i ne% >> stest.txt
@cho arg0: % >> stest.txt
@cho argl: % >> stest.txt
@cho arg2: 9% >> stest.txt
@cho arg3: %3 >> stest.txt
@cho arg4: % >> stest.txt
@cho argh: 9% >> stest.txt
@cho arg6: % >> stest.txt
@cho arg7: % >> stest.txt
@cho arg8: %8 >> stest.txt
@cho arg9: %9 >> stest.txt

@cho. >> stest.txt

This is a sample execution parameter string for the script above:

Ti me: % me%
Severity: %Severity%
Resour ce: %Resour ce%

Server: %op_resource%

KPI : %Pl %

State: %Current _state%

URL: #5CC_URL%

The script’s ouput might look like this:

Tue 12/15/2009 14:54:45.58

arg0: C \project\sccmain\script-test. bat
argl: Time:"Mn Dec 21 21:30:04 2009"
arg2: Severity: CRI Tl CAL

arg3: Resource:"SCC Tester 1"

arg4:. Server:"SCC Tester 1"

arg5: KPl: kpi_scc_nostate_primary
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arg6: State: ERROR
arg7: HYPERLINK "http://ik-scc.sybase.com 8282/ scc"URL: http://i k-
scc. sybase. com 8282/ scc

ar g8:
ar g9:

See also

o Setting Replication Parameters on page 35
»  Optional Configuration Steps on page 52

o Alerts

» Replication Data Collections on page 17
e Key Performance Indicators and Key Performance Areas for Replication on page 18

Replication Alert Templates

Configure

Lists and describes alert templates you can use to create alert instances for Replication.

The alert templates are based on the same key performance indicators (KPIs) that are collected
for the performance and availability monitor displays, and for the Statistics Chart.

Change

Server connection for the primary da-
tabase changes state.

Replication Ob- |Alert Template |Description Alert
jects Type
Replication Server State Change The alert to send when a Replication | State
Server state changes.
Memory Usage The alert to send when a Replication | Threshold
Server memory usage is above the
configured threshold.
Partition Usage The alert to send when a Replication | Threshold
Server partition's usage is above the
configured threshold.
Paths Path State Change The alert to send when a replication | State
path's state changes.
Change in Path Ac- | The alert to send when the numbers of | Threshold
tivity operations sent on a replication path is
above the configured threshold.
Connections Connection State The alert to send when a Replication | State

Sybase Control Center for Replication
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Replication Ob- |Alert Template |Description Alert
jects Type
DSI Activitiy The alert to send when the numbers of | Threshold
operations sent on a Replication Serv-
er DSI connection is above the con-
figured threshold.
DSI Activity per The alert to send when the numbers of | Threshold
Second operations sent on a Replication Serv-
er DSI connection per second is above
the configured threshold.
Logical Connections | Logical Connection | The alert to send when a Replication | State
State Change Server logical connection changes
state.
Routes Route State Change | The alert to send when a Replication | State
Server route's state changes.
Route Activity The alert to send when the change in | Threshold
number of bytes sent through a Repli-
cation Server route is above the con-
figured threshold.
Route Activity per | The alert to send when the number of | Threshold
Second bytes sent through a Replication Serv-
er route per second is above the con-
figured threshold.
Queues Number of Com- The alert to send when the number of | Threshold
mands Written commands written to a Replication
Server queue is above the configured
threshold.
Number of Com- The alert to send when the number of | Threshold
mands Written per | commands written to a Replication
Second Server queue per second is above the
configured threshold.
Number of Com- The alert to send when the number of | Threshold

mands Read

commands read from a Replication
Server queue is above the configured
threshold.
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Replication Ob- |Alert Template |Description Alert
jects Type
Number of Com- The alert to send when the number of | Threshold
mands Read per Sec- | commands read from a Replication
ond Server queue per second is above the
configured threshold.
Size of Commands | The alert to send when the number of | Threshold
Written commands bytes written to a Replica-
tion Server queue is above the config-
ured threshold.
Size of Commands | The alert to send when the number of | Threshold
Written per Second | bytes written to a Replication Server
queue is above the configured thresh-
old.
Queue Size The alert to send when the size of a | Threshold
Replication Server queue is above the
configured threshold.
Partitions Partition Usage The alert to send when a Replication | Threshold
Server partition's usage is above the
configured threshold.
Replication Agent State Change The alert to send when a Replication | State
and Mirror Replica- Agent state changes.
tion Agent .
Memory Usage The alert to send when a Replication | Threshold
Agent memory usage is above the
configured threshold.
LTI Input Queue The alert to send when the number of | Threshold
Size change sets in a Replication Agent
Log Transfer Interface (LTI) input
queue is above the configured thresh-
old.
LTI Output Queue | The alert to send when the number of | Threshold

Size

change sets ina Replication Agent LTI
output queue is above the configured
threshold.
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Replication Ob- |Alert Template |Description Alert
jects Type

Number of LTL The alert to send when the number of | Threshold
Commands Sent Replication Agent Log Transfer Lan-

guage (LTL) commands sent to Rep-

lication Server is above the configured

threshold.
Number of LTL The alert to send when the number of | Threshold
Commands Sent per | Replication Agent LTL commands
Second sent to Replication Server per second

is above the configured threshold.
Number of Opera- | The alert to send when the number of | Threshold
tions Scanned operations scanned by a Replication

Agent Log Reader is above the con-

figured threshold.
Number of Opera- | The alert to send when the number of | Threshold
tions Scanned per operations scanned by a Replication
Second Agent Log Reader per second is above

the configured threshold.
Number of Opera- | The alert to send when the number of | Threshold
tions Processed operations processed by a Replication

Agent Log Reader is above the con-

figured threshold.
Number of Opera- | The alert to send when the number of | Threshold
tions Processed per | operations processed by a Replication
Second Agent Log Reader per second is above

the configured threshold.
Number of Opera- | The alert to send when the number of | Threshold
tions Skipped operations skipped by a Replication

Agent Log Reader is above the con-

figured threshold.
Number of Opera- | The alert to send when the number of | Threshold

tions Skipped per
Second

operations skipped by a Replication
Agent Log Reader per second is above
the configured threshold.
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Replication Ob- |Alert Template |Description Alert
jects Type
Number of Mainte- | The alert to send when the number of | Threshold
nance-User Opera- | maintenance-user operations skipped
tions Skipped by a Replication Agent Log Reader is
above the configured threshold.
Number of Mainte- | The alert to send when the number of | Threshold
nance-User Opera- | maintenance-user operations skipped
tions Skipped per by a Replication Agent Log Reader
Second per second is above the configured
threshold.
Log Reader Queue | The alert to send when the size (in Threshold
Size bytes) of a Replication Agent Log
Reader input queue is above the con-
figured threshold.
Log Reader Scan The alert to send when the size (in Threshold
Buffer Size bytes) of a Replication Agent Log
Reader scan buffer is above the con-
figured threshold.
Adaptive Server En- | State Change The alert to send when an Adaptive State
terprise Server state changes.
Adaptive Server Rep- | RepAgent Thread The alert to send when an Adaptive | State
Agent Thread State Change Server RepAgent Thread changes
state.
Transaction Log The alert to send when the size of an | Threshold
Size Adaptive Server RepAgent Thread's
transaction log is above the configured
threshold.
Number of Log Op- | The alert to send when the number of | Threshold
erations Scanned per | log operations scanned per second by
Second an Adaptive Server RepAgent Thread
is above the configured threshold
Number of Log Op- | The alert to send when the number of | Threshold
erations Processed log operations processed per second
per Second by an Adaptive Server RepAgent

Thread is above the configured thresh-
old.
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See also

o Alert Types, Severities, and States for Replication on page 48
o Substitution Parameters for Scripts on page 51
o Alert-triggered Scripts on page 50

Alert Types, Severities, and States for Replication
Learn about the properties that define and control alerts.

An alert’s type determines what causes it to fire.

Table 9. Alert types

Type Description

State A state alert fires when the metric on which it is based changes to a particular state.
The possible states are running, pending, stopped, warning, error, and unknown.

Threshold A threshold alert fires when the metric on which it is based passes a preset level.

Alert severities control when an alert is issued. You can configure the states or threshold values
for each alert.

Table 10. Alert severities

Severity Description
Normal No alert is issued.
Warning A problem has given cause for concern. An alert is issued; you can subscribe to

alerts that fire at the Warning level.

Critical A serious problem exists. An alert is issued; you can subscribe to alerts that fire at
the Critical level.

States are used on the dashboards, heat chart, and topology icon decorators.

Table 11. Replication States

Replication Ob- | State Description
ject
Replication Server | Running Replication Server is in Active or Quiesce state.
Warning Replication Server is in Suspect state.
Stopped Replication Server is in Rebuilding, Hibernating,
Recovering, and Standalone state.
Error Replication Server is in Down state.
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Replication Ob- | State Description
ject
Unknown The state of the Replication Server cannot be de-
termined.
Replication Server | Running Replication Server connection is in Active or
Connection Hidden state.
Stopped Replication Server connection is in Suspended
state.
Unknown The state of the Replication Server connection

cannot be determined.

Replication Server | Running Replication Server logical connection is in Active
Logical Connection state.
Stopped Replication Server logical connection is in Sus-
pended state.
Unknown The state of the Replication Server logical con-

nection cannot be determined.

Replication Server | Running Replication Server route is in Active state.
Route
Stopped Replication Server route is in Suspended state.
Unknown The state of the Replication Server route cannot

be determined.

Replication Path Running Replication path is in Active state.
Stopped Replication path is in Suspended state.
Unknown The state of the Replication path cannot be deter-
mined.
Replication Agent | Running Replication Agent is in Replicating state.
Stopped Replication Agent is in Admin state.
Error Replication Agent is in Down state.
Unknown The state of the Replication Agent cannot be de-
termined.
Adaptive Server Running Adaptive Server Replication Agent thread is in
Replication Agent Active state.
Thread
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Replication Ob- | State Description
ject
Stopped Adaptive Server Replication Agent thread is in
Suspended state.
Error Adaptive Server Replication Agent thread is in
Down state.
Replication-Only Running Replication-only Adaptive Server is in Active
Adaptive Server state.
Error Replication-only Adaptive Server is in Down
state.
Unknown The state of the Replication-only Adaptive Server

cannot be determined.

See also

» Replication Alert Templates on page 43

e Substitution Parameters for Scripts on page 51
o Alert-triggered Scripts on page 50

Alert-triggered Scripts

You can write a shell script and configure an alert to execute the script.

Use scripts to help manage and respond to alerts. A script might trigger a visual alarm in a
control center or send e-mail about the alert to a list of addresses (a way of supplementing the
alert subscription feature, which accepts a single address).

When you configure an alert to execute a script, you:

» Specify the states or thresholds that set off the alert
» Specify the severity level that triggers execution of the script
« Supply an execution parameter string to be passed to the script

Scripts are executed under the login account used to start Sybase Control Center. Make sure
that account has permissions that allow it to perform the actions contained in all scripts.

Warning! Use caution in writing scripts. A poorly designed script can cause a blocking
situation, creating a lock-up in your Sybase Control Center server.

See also

e Replication Alert Templates on page 43

» Alert Types, Severities, and States for Replication on page 48
e Substitution Parameters for Scripts on page 51
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Substitution Parameters for Scripts

In the execution parameter string you supply to be passed to your shell script, you can include
substitution parameters that are replaced at execution time with values from the alert that
triggers the script.

Substitution parameters are available for both state-based and threshold-based alerts.

Table 12. Substitution Parameters for State-based Alerts

Parameter Description

%Alert% A three-part name supplied by the alert system. It includes the
names of this alert, the resource, and the key performance indi-
cator on which this alert is based.

%Current_state% The current state of the resource on which this alert is config-
ured.

%KPI1% The name of the key performance indicator on which this alert is
based.

%Resource% The name of the resource with which this alert is associated.

%SCC_URL% A link to Sybase Control Center, where more information about

the alert may be available.

%Severity% The severity of this alert: critical or warning.

%Source_application% The application on the managed resource that generated this
alert.

%Time% The date and time at which the alert fired, in this format:

Tue Sep 15 10:10:51 2009

%Top_resource% The name of the alerted resource’s top-level parent resource.
This is valuable when the alerted resource is a component of a
larger system (a database in a server, for example). If the alerted
resource has no parent, %Top_resource% and %Resource%
have the same value.

Table 13. Substitution Parameters for Threshold-based Alerts

Parameter Description

%Alert% A three-part name supplied by the alert system. It includes the
names of this alert, the resource, and the key performance indi-
cator on which this alert is based.
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Parameter

Description

%Datapoint%

The current value, on the alerted resource, of the KPIl on which
this alert is based.

%KPI1% The name of the key performance indicator on which this alert is
based.
%Resource% The name of the resource with which this alert is associated.

%SCC_URL%

A link to Sybase Control Center, where more information about
the alert may be available.

%Severity%

The severity of this alert: critical or warning. (Critical is more
serious.)

%Source_application%

The application on the managed resource that generated this
alert.

%Threshold%

The threshold value at which this alert fires.

%Time%

The date and time at which the alert fired, in this format:

Tue Sep 15 10:10:51 2009

%Top_resource%

The name of the alerted resource’s top-level parent resource.
This is valuable when the alerted resource is a component of a
larger system (a database in a server, for example). If the alerted
resource has no parent, %Top_resource% and %Resource%
have the same value.

See also

e Replication Alert Templates on page 43
o Alert Types, Severities, and States for Replication on page 48
o Alert-triggered Scripts on page 50

Optional Configuration Steps

Perform additional configuration, including user authorization, alerts, data collection
scheduling, backups, and setting purging options for the repository.
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Configuration area |Description Topic

User authorization Set up groups of users or assign roles. User Authorization
Make sure there are users with adminis-
trative privileges (sccAdminRole).

Authentication Add authentication modules to allow Setting Up Security
Windows, UNIX, or LDAP users to log in
to Sybase Control Center.

Alerts Modify alert thresholds and subscriptions | Alerts
and delete alerts.

Data collection Modify collection intervals and sched- Job Scheduling
ules, suspend and resume the schedule,
and delete collection jobs.

Resources Unregister resources, add them to per- Resources
spectives, or remove them.

Perspectives Create, remove, and rename perspectives. | Perspectives

Repository Set purging options and schedule backups | Repository
of the repository database.

See also

e Creating an Alert on page 40
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Manage and Monitor

Manage and Monitor the servers and their components in the replication environment.

Heat Chart

The heat chart displays status and availability statistics for managed resources in the current
perspective.

The heat chart displays the state of resources in your perspective—whether the resources are
running, suspended, or down. In addition, the heat chart lists the type of each resource and
provides statistical data, including the start time of the last data collection.

In the Perspective Heat Chart view, you can filter the resources that you want to see. You can
also search and sort the results by column. From within the Perspective Heat Chart, you can
right-click a resource to see a menu of monitoring and administrative options that vary based
on the resource type.

Heat chart data is collected directly from managed servers, tagged with the date and time when
it was collected, and stored in the Sybase Control Center repository.

See also

»  Historical Performance Monitoring on page 56

e Replication Latency on page 73

* Auvailability Monitoring on page 58

e Key Performance Indicators and Key Performance Areas for Replication on page 18

Displaying Resource Availability
Use the heat chart to view availability information on the servers in the current perspective.

1. From the application menu bar, select View > Open > Heat Chart.

2. (Optional) Todisplay tools for filtering (narrowing the list of resources in the heat chart) or
changing the columns, select View > Filter from the Perspective Heat Chart menu bar.
The Filter and Column tools appear in the left pane.

3. (Optional) To use filtering, select View > Filter from the view’s menu bar and enter a
search term in the Filter string field.

The search term can be any string that appears in the tabular portion of the heat chart, such
as the name, or part of the name, of a server or a resource type (ASE Server, for example).

4. (Optional) Select a filtering setting:
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* Match case — search for resources whose displayed data includes the search term,
including uppercase and lowercase letters; or

» Exact match —search for resources whose displayed data includes an item identical to
the search term.

(Optional) Select a column from the Filter on list to restrict your search to that column.
(Optional) Click Columns to customize your heat chart.
(Optional) Unselect any column that should not appear in your heat chart.

(Optional) Click the sorting arrow in the column headers to sort the column values in either
ascending or descending order.

9. (Optional) Right-click the resource’s row to view a menu of options for the selected
resource.

10. (Optional) To resize the Filter and Columns tools pane, move your mouse over the border
between the tools pane and the resource table. When the mouse cursor changes to a resize
icon, click and drag the border to the left or the right.

11. (Optional) To hide the Filter and Columns tools, unselect View > Filter.

© N o !

See also
»  Graphing Performance Counters on page 56
e Configuring Repository Purging

Historical Performance Monitoring

Monitor performance data to determine whether your environment is working efficiently.

Obtain detailed information about the status of the resources in your environment. You can
create performance graphs that illustrate resource performance over a specified period of
time.

See also

e Heat Charton page 55

» Replication Latency on page 73

» Auvailability Monitoring on page 58

» Key Performance Indicators and Key Performance Areas for Replication on page 18

Graphing Performance Counters
Generate a graph for any set of performance counters to show performance trends.

Prerequisites
Verify that statistical data to be graphed has been collected. To verify data collection, go to the
Collection Jobs page of the Resource Properties view and check the History tab for a
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collection job. You can also look at the resource monitor: if data is displayed, data is being
collected.

1. In the Perspective Resources view, click a resource and select Resource > Launch
Statistics Chart in the view menu bar.

2. Expand the folders in the Statistics tab and select the key performance indicator (KPI) you
want to graph.

3. Click Graph Statistic or drag the KPI onto the Chart tab.
The Chart tab displays the graphed data, while the KPI with its corresponding value and
the date and time it was collected appear in the Data tab.

4. (Optional) Repeat to add additional KPIs to the graph.

5. (Optional) Use the slider at the bottom of the Chart tab to control the amount of time
covered by the graph, ranging from a minute to a year.

6. (Optional) Use <<, <, >, and >> to move the displayed graph to an earlier or later time,
depending on how the slider is set.

7. (Optional) You can click the date/time that appear above the slider. Use these to change the
start and end date/time and the chart time span.

8. (Optional) Click Clear Graph to remove all the graphed statistics and start anew.

Note: You can graph a maximum of five statistics with no more than two distinct units of
measure. By default, only 24 hours of statistics are available; change the repository purge
options to save statistics for a longer period.

See also
e Configuring Repository Purging
» Displaying Resource Availability on page 55

Manage and Monitor Sybase Control Center for Replication

Manage and monitor Sybase Control Center for Replication through performance statistics
information and component's activity logs.

Viewing the Replication Component Log
Launch the Sybase Control Center Log Viewer to display replication activity log.

Prerequisites

Verify the you are in a replication monitoring view.

From any replication monitoring view, click the notebook icon in the left corner of the status
bar. The status bar is at the bottom of a monitoring view.
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See also
e Logging

Manage and Monitor the Replication Environment

Monitor the availability of the servers in the replication environment, control the flow of data
and configure replication parameters to improve server performance.

Availability Monitoring

The statistics allow you to monitor the availability of each server and the state of the
components, such as connections and routes, in a replication environment.

The status of a server is determined by its availability, whether it is up or down, and the state of
the components within the server. The status of the server is a roll-up of the status of all the
components within it.

Availability monitoring provides you with the information to determine not only the
availability of the servers but also their effectiveness in the replication environment. There are
a number of availability monitoring statistics that are gathered for replication. The process of
gathering these statistics is turned on by default with the default interval time.

See also

»  Historical Performance Monitoring on page 56

e Heat Charton page 55

e Replication Latency on page 73

» Key Performance Indicators and Key Performance Areas for Replication on page 18

Replication Topology

Replication topology is a graphical representation of how the servers in a replication
environment are connected to each other. A topology or network diagram illustrates how data
moves in a replication environment.

It provides a visual map of the availability of the replication environment. The lines on a
topology diagram represent the servers, connections, and routes from the source to the target
data server.

See also
e Replication Latency on page 73
*  Replication Monitors on page 60

58

Sybase Control Center



Manage and Monitor

Replication Tracing
Replication tracing provides the information you need to determine the source, target, and the
path of the data flow anywhere in the replication environment.

Replication tracing supports large, complex, and geographically dispersed networks and these
component types:

* Sources — these are servers, databases, tables, stored procedures, and all components to
which Replication Agents provide access.

* Targets — these are servers, databases, tables, and stored procedures.
» Replication Paths — these are connections, routes, and intermediate Replication Servers.

Displaying Replication Tracing from Target to Source
Select a database server and show the data flow path.

Prerequisites
Add all the servers to be monitored to the Perspective Resources view, and verify that you have
the permission to perform this task.

1. From the Perspective Resources view, right-click a Replication Server and select View
Replication Topology.
2. Right-click a target database server and select Trace Replication Sources.

The traced servers, connections, and routes are highlighted in the topology view. The list of
servers that participate in the trace are displayed in the Replication Tracing tab.

Note: There can be more than one source, depending on the replication environment.

3. (Optional) To remove the replication tracing, right-click a server and select Clear
Replication Tracing.

See also
» Displaying Replication Tracing from Source to Targeton page 59
» Displaying Replication Tracing for a Replication Server on page 60

Displaying Replication Tracing from Source to Target
Select a database server and show the data flow path, which includes the final target
destination.

Prerequisites
Add all the servers to be monitored to the Perspective Resources view, and verify that you have
the permission to perform this task.

1. From the Perspective Resources view, right-click a Replication Server and select View
Replication Topology.

2. Right-click a source database server and select Trace Replication Targets.

Sybase Control Center for Replication 59



Manage and Monitor

The traced servers, connections, and routes are highlighted in the topology view. The list of
servers that participate in the trace are displayed in the Replication Tracing tab.

Note: There can be more than one target, depending on the replication environment.

3. (Optional) To remove the replication tracing, right-click a server and select Clear
Replication Tracing.

See also
» Displaying Replication Tracing from Target to Source on page 59
» Displaying Replication Tracing for a Replication Serveron page 60

Displaying Replication Tracing for a Replication Server
Select a Replication Server and display all the data flow paths through the replication
environment, including other Replication Servers, Replication Agents, and database servers.

Prerequisites
Add all the servers to be monitored to the Perspective Resources view, authenticate these
servers, and verify that you have the permission to perform this task.

1. From the Perspective Resources view, right-click a Replication Server and select View
Replication Topology.

2. Right-click a Replication Server and select Trace Replication Server.

3. (Optional) To change the layout type and orientation of the topology, use the View
Controls tab on the left. You can also use the additional options that control the way the
topology appears.

4. (Optional) To view the list of nodes and edges included in the current topology, select the
Details tab on the left.

To retain any changes you have made to the default layout settings of the replication topology,
close Sybase Control Center without closing the Replication Topology view.

See also
» Displaying Replication Tracing from Target to Source on page 59
» Displaying Replication Tracing from Source to Targeton page 59

Replication Monitors
Replication monitors display the availability and critical performance statistics of a particular
component in the replication environment.

The replication monitors provide the status of Replication Servers, Replication Agents, and
replication paths. Each monitor also provides a Quick Admin view to allow you to control the
flow of data and configure replication parameters, a list of replication paths, and a status bar
for each view.

The Replication Server Monitor includes these views:
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* Overview — displays high-level information, such as the server name, version, and its
status. It also displays the memory usage graph, and a bar chart for partitions and the Top
10 queues by size.

» Paths — displays a table of Replication Server paths, including its state, activity, latency,
and latency monitoring status information. It also displays the latency history chart of a
Replication Server.

« Connections — displays the information for Replication Server connections, which
include the name, Replication Agent (RA) status, and Data Server Interface (DSI) status. It
also shows these graphs for the selected connection:

« DSl activity and Stable Queue Transaction (SQT) cache
e Transactions removed from SQT

» Transaction activity

+ Transaction success rate

e Group and batch size

* Logical Connections — displays the Replication Server logical connection information in
a warm-standby environment.

* Routes — displays the Replication Server route information, which includes the name,
route status, and the route's activity graph.

* Queues —displays Replication Server queues information, which includes the name and
type. It also shows these graphs for the selected queue :

¢ Queue reads and writes

* Queue bytes and cache

e SQT cache (only for inbound queues)

« Backlog

* Duplicates detected

« Transactions Removed from SQT (only for inbound queues)
« Distributor activity (only for inbound queues)

The Replication Agent Monitor includes this view:

* Overview — displays high-level information, which includes the status, name, version
number of the server, primary connection, primary host, Replication Server connection,
and the information on when it was last started. It displays a list of paths, which you can
click to open a path dashboard. It also displays these graphs:

« Java Virtual Machine (JVM) memory usage
e LTI activity and queue sizes
» Log Reader activity, queue sizes, and scan buffer

The Adaptive Server Replication Agent Thread Monitor has this view:

* Overview —displays high-level information, such as the name, status, and controlling
Replication Server. It also displays the log and activity details in a graph format.

The Replication Path Dashboard has this view:
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Overview — displays a detailed information of a particular path, which includes its name,
status, data loss detection result, and these graphs:

» Adaptive Server RepAgent thread commands sent per second

« Inbound queue activity for the primary database

* Outbound queue activity for the replicate database

« Database Server Interface (DSI) commands sent per second

e Latency

e Latency history

See also

Replication Latency on page 73
Replication Topology on page 58

Data Flow Control

Controlling data flow comprises one part of troubleshooting in your replication environment.

The other part is tuning servers and components. You use either or both of the methods based
on the problems in the environment.

See also

Replication Environment on page 1

Replication Servers on page 63

Replication Agents on page 70

Replication Paths on page 72

Compatibility Matrix on page 3

Quiescing or Resuming Replication Serveron page 67

Suspending or Resuming a Connection's Replication Agent on page 67
Suspending or Resuming a Connection on page 68

Suspending or Resuming a Route on page 69

Starting or Stopping an Adaptive Server RepAgent Thread on page 72
Configuring Replication Server and Replication Agent Parameters on page 35
Configuring Connection Parameters for Replication Serveron page 36
Configuring Logical Connection Parameters for Replication Serveron page 37
Configuring Route Parameters for Replication Server on page 37

Configuring Adaptive Server RepAgent Thread Parameters on page 38
Configuring Replication Server to Gather Zero Values for Counters on page 39
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Replication Servers
Replication Server maintains replicated data in multiple databases while ensuring the integrity
and consistency of the data.

Replication Server provides clients using databases in the replication system with local data
access, thereby reducing load on the network and centralized computer systems.

See also

*  Replication Environment on page 1
» Data Flow Control on page 62

* Replication Agentson page 70

* Replication Paths on page 72

e Compatibility Matrix on page 3

* Replication Agentson page 70

* Replication Paths on page 72

Displaying Replication Server Status
View the most recent Replication Server statistics. Sybase Control Center automatically
updates the page when new status and statistical values are collected.

Prerequisites
Register and add all the servers to be monitored to the Perspective Resources view,
authenticate them, and verify that you have permission to perform this task.

1. From the Perspective Resources view, right-click a Replication Server and select
Monitor.
The Replication Server monitor view appears, with the Overview as the default display.

2. (Optional) To maximize or minimize a window within the monitor view, click the
maximize or restore window icon in its right corner.

Note: You can also view the server status through the status badges on the server icons in the
Perspective Resources, Perspective Heat Chart, Resource Explorer, and Replication Topology
views.

See also

» Displaying Logical Connection Status on page 64
e Hiding Connection Thread Status on page 65

» Displaying Queue Status on page 66

» Displaying Route Status on page 66

» Logical Connection View Details on page 64

Sybase Control Center for Replication 63



Manage and Monitor

Displaying Logical Connection Status

View the information of all logical connections of a Replication Server in a warm standby
replication environment.

Prerequisites
Verify that the replication environment has been configured, and all servers have been
registered and authenticated, and that the monitoring collection has been running.

1.

From the Perspective Resources view, right-click a Replication Server and select
Monitor.

Click Logical Connections.

Alist of all logical connection names along with their state information, active and standby
connection names, their respective state information, and the inbound queue information
for each logical connection appears in a table.

(Optional) Click the active or standby connection in the list to go to the Connections view,
and see the status information of the physical connections that are associated with the
logical connections.

(Optional) Click the inbound queue under its corresponding column to go to the Queues
view.

See also

Displaying Replication Server Status on page 63
Hiding Connection Thread Status on page 65
Displaying Queue Status on page 66

Displaying Route Status on page 66

Logical Connection View Details on page 64

Logical Connection View Details

The columns on the Logical Connection view show different information about the logical
connections of a Replication Server.

Column Description

Name The DBID (database 1D) for the current logical connection.

State The state of the current logical connection. The possible values are:
e Active

« Switching Active Connection
e Creating Standby Connection

Active Connection The DBID, the data server, and the database name for the current

active database.
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Column Description

Active State The state of the active connection's RepAgent thread. The possible
values are:
e Active

e Suspended

Standby Connection The DBID, the data server, and the database name for the current
standby database.
Standby State Shows the Data Server Interface (DSI) state of the standby con-

nection. The possible values are:

e Active
¢ Suspended

Inbound Queue The name of the inbound queue for a logical connection.

See also

» Displaying Replication Server Status on page 63
» Displaying Logical Connection Status on page 64
e Hiding Connection Thread Status on page 65

» Displaying Queue Status on page 66

» Displaying Route Status on page 66

Hiding Connection Thread Status
Hide the connection status of a Replication Agent or Data Server Interface (DSI) thread.

Prerequisites
Verify that the replication environment has been configured and that all servers have been
registered, authenticated, and replicating data correctly.

1. From the Perspective Resources view, right-click a Replication Server and select
Monitor.

Click Connections.
Select a Replication Server connection.
Click Quick Admin.

In the Hide Connection Status section of the Control tab, click either Hide RepAgent
Status or Hide DSI Status to override the connection's current configuration.

6. Click Apply.

a > wD

See also
» Displaying Replication Server Status on page 63
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o Displaying Logical Connection Status on page 64
» Displaying Queue Status on page 66

» Displaying Route Status on page 66

» Logical Connection View Details on page 64

Displaying Queue Status
View the status information of Replication Server queues in a replication environment.

Prerequisites
Verify that the replication environment has been configured, all servers have been registered
and authenticated, and that monitoring collection has been running.

1. From the Perspective Resources view, right-click a Replication Server and select
Monitor.

2. Click Queues.

3. Select a queue from the table to view its corresponding activity graphs.

4. (Optional) To maximize or minimize a window within the monitor view, click the
maximize or restore window icon in its right corner.

See also

» Displaying Replication Server Status on page 63
» Displaying Logical Connection Status on page 64
e Hiding Connection Thread Status on page 65

» Displaying Route Status on page 66

» Logical Connection View Details on page 64

Displaying Route Status
View the status information of Replication Server routes in a replication environment.

Prerequisites
Verify that the replication environment has been configured, all servers have been registered
and authenticated, and that monitoring collection has been running.

1. From the Perspective Resources view, right-click a Replication Server and select
Monitor.

2. Click Routes.
You can see a route's status in the Replication Server Routes table.

3. Select a route from the table to view its corresponding activity graph.

4. (Optional) To maximize or minimize a window within the monitor view, click the
maximize or restore window icon in its right corner.

See also
» Displaying Replication Server Status on page 63
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o Displaying Logical Connection Status on page 64
e Hiding Connection Thread Status on page 65

» Displaying Queue Status on page 66

» Logical Connection View Details on page 64

Quiescing or Resuming Replication Server

Shut down data flow from all sources and quiesce the current Replication Server or resume
data flow from the up-stream replication path. You may need to quiesce all Replication
Servers in your environment to recover databases, alter routes, and troubleshoot the system.

Prerequisites
Register and add all the servers to be monitored to the Perspective Resources view, verify that
the default collection is running, and that you have permission to perform this task.

1. From the Perspective Resources view, right-click a Replication Server and select
Monitor.
2. Click Quick Admin.

3. Inthe Control tab, click Quiesce or Resume All.

See also

» Suspending or Resuming a Connection's Replication Agenton page 67

» Suspending or Resuming a Connection on page 68

» Suspending or Resuming a Route on page 69

e Slarting or Stopping an Adaptive Server RepAgent Thread on page 72

»  Configuring Replication Server and Replication Agent Parameters on page 35
e Configuring Connection Parameters for Replication Serveron page 36

e Configuring Logical Connection Parameters for Replication Serveron page 37
» Configuring Route Parameters for Replication Serveron page 37

e Configuring Adaptive Server RepAgent Thread Parameters on page 38

e Configuring Replication Server to Gather Zero Values for Counters on page 39
» Data Flow Control on page 62

Suspending or Resuming a Connection’s Replication Agent
Suspend or resume a connection's Replication Agent that is associated with a Replication
Server.

Prerequisites
Register and add all the servers to be monitored to the Perspective Resources view, verify that
the default collection is running, and that you have permission to perform this task.

1. From the Perspective Resources view, right-click a Replication Server and select
Monitor.
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Click Connections.

Select a connection.

Click Quick Admin.

In the Replication Agent section of the Control tab, click Supend or Resume.

ISR < A

See also

» Quiescing or Resuming Replication Serveron page 67

e Suspending or Resuming a Connection on page 68

e Suspending or Resuming a Route on page 69

» Slarting or Stopping an Adaptive Server RepAgent Thread on page 72

»  Configuring Replication Server and Replication Agent Parameters on page 35
e Configuring Connection Parameters for Replication Serveron page 36

e Configuring Logical Connection Parameters for Replication Serveron page 37
»  Configuring Route Parameters for Replication Serveron page 37

e Configuring Adaptive Server RepAgent Thread Parameters on page 38

e Configuring Replication Server to Gather Zero Values for Counters on page 39
» Data Flow Control on page 62

Suspending or Resuming a Connection
Suspend or resume a Replication Server connection.

Prerequisites
Register and add all the servers to be monitored to the Perspective Resources view, verify that
the default collection is running, and that you have permission to perform this task.

1. From the Perspective Resources view, right-click a Replication Server and select
Monitor.

Click Connections.

Select a connection.

Click Quick Admin.

In the Data Server Interface section of the Control tab, click Suspend or Resume.
(Optional) Click Suspended Immediately.

(Optional) Select one of these options when resuming a connection:

N o g~

« Skip the first transaction. This option is available only for versions of Replication
Server 15.0 or earlier.

« Resume after skipping transactions. Provide the number of transactions to skip. This
option is available only for versions of Replication Server 15.1 and later.

 Execute sytem transaction.
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See also

e Quiescing or Resuming Replication Serveron page 67

» Suspending or Resuming a Connection's Replication Agenton page 67

e Suspending or Resuming a Route on page 69

» Starting or Stopping an Adaptive Server RepAgent Thread on page 72

» Configuring Replication Server and Replication Agent Parameters on page 35
e Configuring Connection Parameters for Replication Serveron page 36

e Configuring Logical Connection Parameters for Replication Serveron page 37
e Configuring Route Parameters for Replication Serveron page 37

e Configuring Adaptive Server RepAgent Thread Parameters on page 38

e Configuring Replication Server to Gather Zero Values for Counters on page 39
» Data Flow Control on page 62

Suspending or Resuming a Route
Suspend or resume a route associated to a Replication Server.

Prerequisites
Register and add all the servers to be monitored to the Perspective Resources view, verify that
the default collection is running, and that you have permission to perform this task.

1. From the Perspective Resources view, right-click a Replication Server and select
Monitor.

Click Routes.

Select a route.

Click Quick Admin.

In the Control tab, click Suspend or Resume.

o gk wd

(Optional) Click Skip transaction with large message when resuming a route.

Note: This option applies only to direct routes where the site version at the replicate site is
12.1 or earlier.

See also

e Quiescing or Resuming Replication Serveron page 67

« Suspending or Resuming a Connection's Replication Agenton page 67

» Suspending or Resuming a Connection on page 68

 Starting or Stopping an Adaptive Server RepAgent Thread on page 72

»  Configuring Replication Server and Replication Agent Parameters on page 35
e Configuring Connection Parameters for Replication Serveron page 36

e Configuring Logical Connection Parameters for Replication Serveron page 37
»  Configuring Route Parameters for Replication Serveron page 37

e Configuring Adaptive Server RepAgent Thread Parameters on page 38
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e Configuring Replication Server to Gather Zero Values for Counters on page 39
» Data Flow Control on page 62

Replication Agents
Replication Agents enable the movement and sharing of data where and when it is needed -
into data warehouses, data marts, OLTP applications and mobile workforce.

Replication Agents allows heterogeneous data servers to act as primary data servers in a
replication system based on Sybase replication technology.

See also

e Replication Environmenton page 1
e Data Flow Control on page 62

» Replication Serverson page 63

e Replication Paths on page 72

e Compatibility Matrix on page 3

» Replication Serverson page 63

e Replication Paths on page 72

Displaying Replication Agent Status
Review high-level server availability by viewing the Replication Agent or Mirror Replication
Agent status.

Prerequisites
Register and add all the servers to be monitored to the Perspective Resources view,
authenticate them, and verify that you have permission to perform this task.

1. From the Perspective Resources view, right-click a Replication Agent and select
Monitor.

The monitor view appears displaying high-level information, which includes the status of
the selected Replication Agent.

2. (Optional) To maximize or minimize a window within the monitor view, click the
maximize or restore window icon in its right corner.

See also
» Displaying RepAgent Thread Status in Adaptive Serveron page 71

» Suspending or Resuming a Replication Agent or Mirror Replication Agenton page
71

» Slarting or Stopping an Adaptive Server RepAgent Thread on page 72
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Displaying RepAgent Thread Status in Adaptive Server
View the RepAgent thread status in an Adaptive Server, either single instance or shared disk
cluster, for replication.

Prerequisites
Register and add all the servers to be monitored to the Perspective Resources view,
authenticate them, and verify that you have permission to perform this task.

1. From the Perspective Resources view, right-click an Adaptive Server and select
Monitor.
The Replication Agent Thread Monitor appears. You can view the status of an Adaptive
Server RepAgent thread in the displayed table with its name and the controlling
Replication Server information.

2. (Optional) To maximize or minimize a window within the monitor view, click the
maximize or restore window icon in its right corner.

See also

« Displaying Replication Agent Status on page 70

» Suspending or Resuming a Replication Agent or Mirror Replication Agent on page
71

» Slarting or Stopping an Adaptive Server RepAgent Thread on page 72

Suspending or Resuming a Replication Agent or Mirror Replication Agent
Suspend or resume a Replication Agent or a Mirror Replication Agent in a replication
environment.

Prerequisites
Register and add all the servers to be monitored to the Perspective Resources view, verify that
the default collection is running, and that you have permission to perform this task.

1. From the Perspective Resources view, right-click a Replication Agent or a Mirror
Replication Agent and select Monitor.
2. Click Quick Admin.

3. Inthe Control tab, click Suspend or Resume.

See also

» Displaying Replication Agent Status on page 70

» Displaying RepAgent Thread Status in Adaptive Serveron page 71

» Starting or Stopping an Adaptive Server RepAgent Thread on page 72
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Starting or Stopping an Adaptive Server RepAgent Thread
Start or stop a RepAgent thread of an Adaptive Server.

1. From the Perspective Resources view, right-click an Adaptive Server and select
Monitor.

2. Select a RepAgent thread (ASE Server, Replication Only) or click Replication Agent in
the left pane, then select a RepAgent thread (ASE Server).

3. Click Quick Admin.

4. Inthe Control tab, click Start or Stop.

5. (Optional) Click Stop immediately before clicking Stop.

See also

e Quiescing or Resuming Replication Serveron page 67

» Suspending or Resuming a Connection's Replication Agenton page 67

e Suspending or Resuming a Connection on page 68

e Suspending or Resuming a Route on page 69

»  Configuring Replication Server and Replication Agent Parameters on page 35
e Configuring Connection Parameters for Replication Serveron page 36

e Configuring Logical Connection Parameters for Replication Serveron page 37
»  Configuring Route Parameters for Replication Serveron page 37

e Configuring Adaptive Server RepAgent Thread Parameters on page 38

e Configuring Replication Server to Gather Zero Values for Counters on page 39
e Data Flow Control on page 62

» Displaying Replication Agent Status on page 70

» Displaying RepAgent Thread Status in Adaptive Serveron page 71

o Suspending or Resuming a Replication Agent or Mirror Replication Agenton page 71

Replication Paths
A replication path is the set of all servers and internal components that transactions travel
through when moving from the primary to the replicate database.

See also

»  Replication Environmenton page 1
e Data Flow Control on page 62

» Replication Serverson page 63

e Replication Agentson page 70

o Compatibility Matrix on page 3

» Replication Serverson page 63

» Replication Agentson page 70
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Displaying Replication Path Status
View the status of the servers, connections, routes, and queues that make up a replication
path.

Prerequisites
Register and add all the servers to be monitored to the Perspective Resources view,
authenticate them, and verify that you have permission to perform this task.

1. From the Perspective Resources view, right-click a Replication Server or a Replication
Agent and select Monitor.

2. Click a replication path.
The Replication Path Dashboard for the selected replication path appears.

3. (Optional) To maximize or minimize a window within the monitor view, click the
maximize or restore window icon in its right corner.

If new statistics are collected while the replication path dashboard is displayed, Sybase
Control Center automatically updates the information on the current page.

See also
» Displaying Latency on page 74
» Latency Monitoring Process on page 14

Replication Latency

Replication latency is the amount of time it takes for a transaction that occurs in the primary
database to be applied to the replicate database.

The time includes Replication Agent processing, Replication Server processing, and network
usage. Replication latency appears on the path dashboard.

See also

»  Historical Performance Monitoring on page 56

e Heat Charton page 55

» Auvailability Monitoring on page 58

» Key Performance Indicators and Key Performance Areas for Replication on page 18
« Setting Up the Latency Monitoring Process on page 13

» Replication Topology on page 58

* Replication Monitors on page 60
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Displaying Latency
View latency information to determine the amount of time it takes for a transaction to be
applied from the primary database to the replicate database.

Prerequisites

Add all the servers to be monitored in the Perspective Resources view. Verify that you have
permission to perform this task and that the latency monitoring process has already been
started.

1. From the Perspective Resources view, right-click a server and select Monitor.
2. Click Paths.

3. Select or click a path from the path list.
When you select a path, its latency information appears below the path list. When you click
a selected path, its dashboard opens, displaying the latency history graph.

4. (Optional) Click the bar graph icon in the top right corner of the Latency window to toggle
between the overall latency and the latency monitoring history of the path.

See also

« Setting Up the Latency Monitoring Process on page 13
» Stopping the Latency Monitoring Process on page 74

e Latency Chart Details on page 75

» Displaying Replication Path Status on page 73
 Latency Monitoring Process on page 14

Stopping the Latency Monitoring Process
Stop the latency monitoring process.

Prerequisites

Verify that all servers to be monitored have been registered, authenticated, and added to the
Perspective Resources, that latency monitoring process is running, and that you have the
permission to perform this task.

1. From the Perspective Resources view, right-click a Replication Server and select
Monitor.

2. Click Paths.
3. Select a path where the "Monitoring" value is true.

4. Click Quick Admin to display the latency monitoring process administration view for the
selected path.

5. Click Stop.

74

Sybase Control Center



Manage and Monitor

See also

»  Setting Up the Latency Monitoring Process on page 13
» Displaying Latency on page 74

e Latency Chart Details on page 75

» Latency Monitoring Process on page 14

Latency Chart Details
Learn about the threads that represent the latency chart in the path dashboard.

Table 15. Latency threads

Latency thread Description

Replication Executor Thread The number of seconds from the start, to time the ticket passes
(EXEC) through the EXEC thread.

Distribution (DIST) Thread The number of seconds from the primary Replication Server time

to the time the ticket passes through the DIST thread. For each
primary database managed by a Replication Server, there isa DIST,
which in turn uses Stable Queue Transaction (SQT) to read from
the inbound queue, and Stable Queue Manager (SQM) threads to
write transactions to the outbound queue.

Replication Server Interface The number of seconds from the DIST thread time to the time the
(RSI) Thread ticket passes through the RSI thread. RSI threads send messages
from one Replication Server to another. There is one RSI thread for
each destination Replication Server.

Data Server Interface (DSI) The number of seconds from the RSI thread time to the time the
Thread ticket passes through the DSI thread. The DSI thread translates the
transaction modifications into remote procedure calls (RPC) or the
language as specified by the function strings in the function-string
class assigned to the destination database. Replication Server starts
the DSI threads to submit transactions to a replicate database to
which it has a connection.

Replicate Database The number of seconds from the DSI thread time to the time the
ticket arrived at the replicate database.

Total Latency The number of seconds between the time at origin and destination
for the transaction committed.

See also
o Setting Up the Latency Monitoring Process on page 13
» Stopping the Latency Monitoring Process on page 74
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» Displaying Latency on page 74
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Troubleshoot Sybase Control Center for
Replication

Troubleshoot problems that occur in Sybase Control Center for Replication.

Collection Job for Adaptive Server Fails

Problem: A collection job for Adaptive Server may fail when the number of open databases is
too low.

Solution: Modify the value of number of open databases by using either the Server
Configuration screen of the Adaptive Server monitor, or these steps:

1. Log in to the Adaptive Server.
i sql -S<server_nanme> -l<sa user name> -P<sa password>

2. Run this command to display the current configuration value:
sp_configure 'number of open dat abases'

3. Run this command to change the current configuration value:
sp_configure 'nunber of open databases', <nunber>

Add 10 to the current configuration value and substitute this number for <number>.

Data on Dashboards or Charts Is Missing

Problem: There is no data displayed on the dashboards or on the charts.

Solution: Create collection jobs for Replication Server statistics collections.

See also
o Setting Up the Latency Monitoring Process on page 13

No Data Is Returned for Performance Counters Collection
Job

Problem: No data is returned for the Performance Counters collection job after completing its
execution.

Solution: Let the job execution complete for three cycles. The Replication Server
Performance Counters collection job returns data in the Statistics Chart only after it completes
execution of approximately three cycles.

Sybase Control Center for Replication 77



Troubleshoot Sybase Control Center for Replication

Same Data Is Displayed for Two or More Adaptive Server
Collection Job Executions

Problem: If the interval time of the Adaptive Server RepAgent thread collection job is set to
less than 60 seconds, Sybase Control Center still works but you may get the same data for two
or more continuous executions of the job.

Solution: Do not set the interval time for the Adaptive Server RepAgent thread collection job
to less than 60 seconds. This is because the collection data are updated only once during 60
seconds for better performance.

Servers Are Missing in the Topology View

Problem: There are servers missing when you display the topology view.

Solution: Verify that all the servers have been added to the current perspective because the
topology view can only display servers from current perspective.

Servers, Routes, or Connections Display an Unknown Status

Problem: "Unknown" status is displayed for servers, routes, or connections.

Solution: Verify that a collection job is scheduled and running to display the correct status in
the Replication Topology view.

Some Connector Lines Do Not Display a Status Icon

Problem: Some connector lines do not display a status icon.

Solution: Not all connector lines are associated with a managed object. Those associated with
a managed object are the only ones that display a status icon. Currently, status icons are
displayed only on Replication connections and routes.

78 Sybase Control Center



Troubleshoot Sybase Control Center for Replication

Topology Display Is Incorrect When Two Replication Servers
With the Same Name Are Registered

Problem: When you register two Replication Servers with the same name in a given
replication environment, the replication topology view is displayed incorrectly.

Solution: Do not use the same name for two replication resources. The servers in areplication
environment must have unique names.

Topology View Displays Blank Canvas

Problem: The Replication Topology view displays blank canvas.

Solution: From the Replication Topology view, click Reset to restore the default layout. This
problem is usually due to a layout that is actually displayed off-screen.

Topology View Takes a Long Time to Display

Problem: The Replication Topology view takes a long time to display.

Solution: The Replication Topology view requires data from each server to be displayed. For
large environments, this may take 10 to 15 seconds.

Unable to Retrieve Topology Relationship Data or Server
Objects

Problem: An error message "Unable to retrieve topology relationship data” or "Unable to
retrieve topology server objects" is displayed.

Solution: These errors are displayed for a number of reasons. Perform these:

« Verify that you have the repMonitorRole for each server in the topology assigned to your
login.

« Verify that each server in the topology has been authenticated.

« Theserver relationship data cannot be retrieved from the Replication Management plug-in
or one or more servers cannot be retrieved from the Sybase Control Center.
Check the plug-in and the Unified Agent Framework (UAF) agent log files for errors:
For Windows
« USYBASE% SCC- 3_1\ pl ugi ns\ RVAP\ | og\ r nap. | og
+ USYBASE% SCC-3_1\1 og\ agent . | og
For UNIX
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o $SYBASE/ SCC- 3_1/ pl ugi ns/ RMAP/ | og/ r map. | og
« $SYBASE/ SCC-3_1/10g/ agent. | og
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Glossary: Sybase Control Center for Replication

Definitions of Sybase Control Center terms related to Replication.

» alert— amechanism for notifying administrators when a managed resource experiences a
status change, or when a performance metric passes a user-specified threshold.

« alertinstance — a copy of an alert type that has been configured to generate a particular
kind of alert for a specific managed resource.

« alert notification — an indication that an alert has fired. Alert notifications appear in the
Alert Monitor view. If e-mail notification is enabled, alert notifications are also delivered
to the specified e-mail address.

» alert target — the destination for an alert notification and source of an alert response.

« alert type — (1) A template that defines the resource type and the key performance
indicator associated with an alert instance. (2) The basis on which an alert fires: state or
threshold. Some alerts are triggered by the state of their key performance indicator (for
example, running or stopped), while other alerts are triggered when their KP1’s numerical
value passes a specified threshold.

« alert storm — the result of issuing many redundant alerts associated with a common or
root occurrence. See also alert suppression.

« alert storm suppression — a Sybase Control Center feature that can be configured to
prevent alert storms by suppressing repeat alert notifications for a specified period of time.

« availability — indicates whether a resource is accessible and responsive.

« collection — a named, predefined set of key performance indicators for which values are
collected from monitored servers at the same time. Collections supply the performance
and availability data shown on Sybase Control Center screens and charts. Use the
scheduler to view a list of collections and to control which collections run, how often they
run, and the length of time for which they run.

* component— A server object in a replication environment. Examples of components are
connections, routes, and Replication Agent threads.

e connection — A connection from a Replication Server to a database.

« database — A set of related data tables and other objects that are organized and presented
to serve a specific purpose.

» dataserver — A server that provides the functionality necessary to maintain the physical
representation of a replicated table in a database. An example of a data server is Sybase
Adaptive Server.

« Data Server Interface (DSI) — Replication Server threads corresponding to a connection
between a Replication Server and replicate database. DSI threads submit transactions
from the DSI outbound queue to a replicate database. They consist of a scheduler thread
and one or more executor threads. The scheduler thread groups the transactions by commit
order and dispatches them to the executor threads. The executor threads map functions to
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function strings and execute the transactions in the replicate database. DSI threads use an
Open Client connection to a database. See also connection.

edge — Atopology object representing a relationship between two nodes, displayed in the
form of a line that connects the topology node icons. Edges are usually defined with a
direction.

Enterprise Connect Data Access (ECDA) — An Open-Server-based software gateway
that supports DB-Library and CT-Library application program interfaces and Open
Database Connectivity (ODBC) protocols. It serves as a fundamental building block for
database middleware applications that provides access to hon-Sybase databases.
environment— A set of servers that interact to perform replication. It can be a subset of the
replication domain identified by the 1D server.

event— an activity in the system, such as a user logging in, a service starting or stopping,
or a condition changing. Use the alerts feature to detect and notify you about system
events.

heat chart — a graphical view of resource availability in the current perspective.

ID Server — A Replication Server in a replication system. It assigns unique ID numbers to
every Replication Server and database in the system and maintains the version information
for the system.

job — atask performed by the scheduler in Sybase Control Center.

key performance indicator (KPI) — a single metric used to evaluate the status or
performance of amonitored resource. A KPI value can be a state (such as running, error, or
stopped) or a numerical value. KPIs are grouped into collections (and also, for some
product modules, into key performance areas, or KPAs). KPI values are collected by
scheduled collection jobs and appear on monitoring screens and in the statistics and heat
charts. Examples of KPIs are Server Availability and Number of Blocked Processes.
latency — The measure of the time it takes to distribute a data modification operation from
a primary database to a replicate database. The time includes Replication Agent
processing, possibly ECDA processing—if the replicate database is non-Sybase—
Replication Server processing, and network overhead.

Mirror Activator — Provides an integrated, zero-loss disaster recovery solution when
used in conjunction with a storage replication system. Replication Server, Mirror
Replication Agent, and Enterprise Connect Data Access (ECDA) are the components of
Mirror Activator.

Mirror Replication Agent— A component of a Mirror Activator disaster recovery system
that reads the mirror transaction log of the primary database and sends transaction data as
LTL commands for replicated tables and replicated stored procedures to the primary
Replication Server, which converts the LTL commands into SQL and applies the SQL to
the replicate database.

node — A topology object representing a server or other entity type, displayed visually in
the form of an icon.

partition — Araw disk partition or operating system file that a Replication Server uses for
stable queue storage. See also stable queue.
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* perspective — a named tab in Sybase Control Center that displays information related to a
collection of managed resources (such as servers) and a set of views associated with those
resources. The views in a perspective are chosen by users of the perspective. You can create
as many perspectives as you need, and customize them to monitor and manage your
resources. Perspectives allow you to group resources ways that make sense in your
environment—for example by location, department, or project.

* RepAgent thread — The Replication Agent for a primary Adaptive Server. It reads the
transaction log and sends the transaction data as LTL commands for replicated tables and
replicated stored procedures to the primary Replication server, which converts the LTL
commands into SQL and applies the SQL to the replicate database.

* replication — A process by which the changes to the data in one database—including
creation, updating, and deletion of records—are also applied to the corresponding records
in another database.

* Replication Agent — Reads the transaction log of a primary, non-Sybase database, and
sends transaction data as LTL commands for replicated tables and replicated stored
procedures to the primary Replication Server, which converts the LTL commands into
SQL and applies the SQL to the replicate database.

» replication path — The set of all servers and internal components, such as threads and
queues, that transactions travel through when moving from the primary to the replicate
database.

* repository — adatabase that stores information related to managed resources, along with
user preference data, operational data, and performance statistics.

* resource — aunique Sybase product component (such as a server) or a subcomponent.

* route — A one-way message stream from a source Replication Server to a destination
Replication Server. Routes carry data modification commands (including those for
RSSDs) and replicated functions or stored procedures between Replication Servers.

¢ SCC-enabled login account — a user account that has been granted privileges in Sybase
Control Center by mapping appropriate Sybase Control Center roles. (Roles are typically
mapped to a group to which the account belongs rather than to the account itself.) The user
account and group can be native to Sybase Control Center or created in the operating
system or the LDAP directory service to which Sybase Control Center authentication is
delegated. You must use an SCC-enabled account to log in to Sybase Control Center.

» schedule - the definition of a task (such as the collection of a set of statistics) and the time
interval at which Sybase Control Center executes the task.

» stable queue manager (SQM) — A thread within Replication Server that manages the
stable queues. Replication Server uses one SQM thread for each stable queue, whether
inbound or outbound.

» stable queue — A store-and-forward queue where Replication Server stores messages
destined for a route or database connection. Replication Server builds stable queues using
its disk partitions.
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topology — A graphical representation of how the servers in a replication environment are
connected to each other. It is a network diagram that provides a visual map of the
availability of the replication environment.

view — awindow in a perspective that displays information about one or more managed
resources. Some views also let you interact with managed resources or with Sybase
Control Center itself. For example, the Perspective Resources view lists all the resources
managed by the current perspective. Other views allow you to configure alerts, view the
topology of a replication environment, and graph performance statistics.
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